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Introduction

Welcome to Mac OS X Snow Leopard On Demand, a visual
quick reference book that shows you how to work efficiently
with Apple Mac OS X Snow Leopard.  This book provides
complete coverage of basic to advanced Mac OS X skills.

How This Book Works
You don’t have to read this book in any particular order.
We’ve designed the book so that you can jump in, get the
information you need, and jump out. However, the book does
follow a logical progression from simple tasks to more com-
plex ones. Each task is presented on no more than two facing
pages, which lets you focus on a single task without having
to turn the page. To find the information that you need, just
look up the task in the table of contents or index, and turn to
the page listed. Read the task introduction, follow the step-
by-step instructions in the left column along with screen illus-
trations in the right column, and you’re done.

What’s New
If you’re searching for what’s new in Mac OS X Snow Leop-
ard, just look for the icon: New!. The new icon appears in the
table of contents and throughout this book so you can quickly
and easily identify a new or improved feature in Snow Leop-
ard. A complete description of each new feature appears in
the New Features guide in the back of this book.

Keyboard Shortcuts
Most menu commands have a keyboard equivalent, such as
A+P, as a quicker alternative to using the mouse. A complete
list of keyboard shortcuts is available on the Web at 
www.perspection.com.

How You’ll Learn

How This Book Works

What’s New

Keyboard Shortcuts

Step-by-Step Instructions

Real World Examples

Workshop

Get More on the Web

www.perspection.com
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Step-by-Step
Instructions
This book provides concise step-
by-step instructions that show you
“how” to accomplish a task. Each
set of instructions includes illus-
trations that directly correspond to
the easy-to-read steps. Also
included in the text are time-
savers, tables, and sidebars to
help you work more efficiently or
to teach you more in-depth infor-
mation. A “Did You Know?” pro-
vides tips and techniques to help
you work smarter, while a “See
Also” leads you to other parts of
the book containing related infor-
mation about the task. 

Real World Examples
This book uses real world exam-
ples files to give you a context in
which to use the task. By using
the example files, you won’t waste
time looking for or creating sam-
ple files. You get a start file and a
result file, so you can compare
your work. Not every topic needs
an example file, such as changing
options, so we provide a complete
list of the example files used
through out the book. The exam-
ple files that you need for project
tasks along with a complete file
list are available on the Web at
www.perspection.com.

Real world
examples help
you apply what
you’ve learned
to other tasks.

Illustrations
match the
numbered
steps.

Numbered
steps guide
you through
each task.

Did You Know? alerts
you to tips, techniques
and related information.

See Also points you to
related information in
the book.

Easy-to-follow
introductions
focus on a
single concept.

www.perspection.com


Workshops
This book shows you how to put
together the individual step-by-
step tasks into in-depth projects
with the Workshop. You start each
project with a sample file, work
through the steps, and then com-
pare your results with project
results file at the end. The Work-
shop projects and associated files
are available on the Web at
www.perspection.com.

Get More on the Web
In addition to the information in
this book, you can also get more
information on the Web to help
you get up to speed faster with
Mac OS X. Some of the informa-
tion includes: 

Transition Helpers
◆ Only New Features.

Download and print the new
feature tasks as a quick and
easy guide.

Productivity Tools
◆ Keyboard Shortcuts.

Download a list of keyboard
shortcuts to learn faster ways
to get the job done. 

The Workshops
walks you through
in-depth projects
to help you put
the Mac OS X
Snow Leopard to
work.

Introduction xxi

Additional
content
is available
on the Web.

www.perspection.com
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More Content
◆ Photographs. Download

photographs and other
graphics to use in your
documents.

◆ More Content. Download
new content developed after
publication, such as a chapter
on Using Basic Unix
Commands.

You can access these additional
resources on the Web at
www.perspection.com.

Download and
use Photographs
to help you add
impact to your
documents.

www.perspection.com


Using Mac OS X Applications

Introduction

Now that you know how to work with the graphical elements
that make Mac OS X Snow Leopard work, you’re ready to
work with applications. An application is software you use to
accomplish a specific task, such as word processing or man-
aging files on your computer. Snow Leopard comes with sev-
eral small applications and utilities that are extremely useful
for completing basic tasks, such as creating a written docu-
ment or performing basic calculations. Its suite of applica-
tions let you organize your workflow and create sticky notes.
You can even edit and create digital media for use on the
Internet, CD, or burn it onto a DVD. In addition, Snow
Leopard makes setting up and communicating over the
Internet easier than ever. And, if you happen to own an iSight
(Macintosh Web camera), Snow Leopard helps you communi-
cate with other iSight owners using audio and video. If you
deal with a lot of fonts, Snow Leopard comes packaged with
a font management system second to none. Snow Leopard's
applications are powerful tools for organization, gaming, con-
trolling digital media, and Internet communication, just to
name a few. 6

6
What You’ll Do

Use Mac OS X Applications

Launch and Quit Applications

Open Applications and Files

Work with File Extensions

Switch Between Applications

Use Mac OS X Applications

Create and Edit an Address Book

Manage an Address Book

Add an Image to an Address Book

Play Chess

Perform Calculations and Conversions

Capture Images with a Digital Camera

Capture Screen Shots with Grab

Preview Images and PDF's

Create Sticky Notes

Manage Fonts with Font Book

Activate, Deactivate, and 
Customize Fonts

129
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Mac OS X comes with several accessories,
built-in applications that, while not as feature-
rich as many applications sold separately, are
extremely useful for completing basic tasks. A
frequently used list of Mac OS X applications
is provided here. However, you can view a

complete list of installed applications in the
Applications folder on your hard disk drive.
The Applications folder also contains a
Utilities folder with additional applications
you can use to perform specialized functions,
which are detailed more in later chapters.

Using Mac OS X Applications

Program Description

Address Book Stores names, addresses, and other contact information

AppleScript Automates tasks using a programming language

Automator Automates tasks using workflows and no programming

Calculator Performs arithmetic calculations

Dashboard Provides a screen for mini-program called widgets

Dictionary Provides an illustrated dictionary and thesaurus

Directory Provides access to shared information about people, groups, location and resources.

DVD Player Plays sound, music, and video

Font Book Installs, previews, and manages fonts and font collections

Front Row Provides an entertainment system to play music, movies, TV shows, and podcasts 

iCal Keeps track of calendar appointments

iChat Sends and receives instant messages to online contacts

Image Capture Transfers images from your camera to your computer

iSync Compares information on your computer and devices and updates them to be the same

iTunes Plays digital sound files

Mail Provides e-mail, newsgroup, and directory services

Photo Booth Takes pictures and adds visual effects

Preview Views, rotates, resizes, crops, and converts image files

QuickTime Player Plays and edits media located on your computer, a CD, or Internet

Safari Displays Web (HTML) pages

Spaces Organizes windows into groups, known as spaces, for individual projects

Stickies Creates notes for reminders, lists, and messages

TextEdit Creates, edits, and displays text, Rich Text Format, and Word documents

Time Machine Backs up everything on your computer

Frequently Used Mac OS X Applications
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Installing Other
Applications

Install Third-Party Applications
Downloaded from the Internet

Download the software application
from the Web.

The file typically appears on your
desktop. If you use Safari to
download your application file, it
automatically uncompressed it into
a disk image file (.dmg), so you
don’t have to.

Compressed files use these file
extensions: .sit (standard Mac),
.zip (standard Windows), .tar (tape
archive Unix), .gz (standard Unix),
.tar.gz, or .tgz

If the file is compressed, use the
StuffIt Expander application
(available at www.download.com)
to uncompress the file.

Double-click the disk image file
(.dmg).

A disk icon from the disk image
mounts on your desktop.

Double-click the mounted disk
icon to start the installer program,
and then follow the instructions.   

Drag the disk image file into the
Trash to remove and eject it.

5

4

3

2

1

Mac OS X comes with a set of applications automatically loaded during
the installation of the operating system, and appear on the hard drive
within the Applications folder. All other third-party applications need to
be installed separately. You can install a third-party application by
inserting the software installation CD or DVD and following the instruc-
tions, or by downloading the software from the Web to your hard disk,
uncompressing the file if necessary, starting the installer (typically in a
disk image file, .dmg, which mounts as a disk icon), and following the
instructions. In some cases, an installer application is not used to per-
form an installation. In that case, all you need to do is simply drag the
software files to your hard disk, typically in the Applications folder. To
uninstall an application, simply drag the icon (or its folder) to the Trash.

1

5

3 4

www.download.com
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Launching
Applications

Launch an Application from 
the Dock

Click the Applications folder in the
Dock.

Click the icon you want from the
stack list (New!).

To display additional applications,
click the Utilities folder.

To return back to the Applications
folder, click the Return button in
the upper-left corner of the stack
list.

Launch an Application from a
Finder Window

Double-click the hard drive icon on
your desktop.

To change views, click a view
button, such as View By Columns.

Click the Applications folder or
navigate to the application  folder. 

Double-click on the application
name, or application icon, to
launch.

4

3

2

1

4

3

2

1

All Mac OS X applications are automatically loaded during the installa-
tion of the operating system, and appear on the hard drive within the
Applications folder. All other third-party applications need to be
installed separately. When you open the hard drive, you'll have the
choice of viewing the file as icons, as file names (with information), or
as file names in columns. Regardless of what view you choose to
launch a Mac application, simply locate the desired application in the
open window, and then double-click the application to load. If the appli-
cation is in the Dock or in the Applications folder, you can click the icon
in the Dock or click the Application folder icon in the Dock, and then
click the application  icon from the stack list (New!).

2 3 4
Application details
are displayed

1

2

4
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As you open applications and files, their names are kept in the Recent
Items submenu in the Apple menu for easy access the next time you
want to open a specific application or file. The Mac OS has always
allowed you to double-click a document icon to launch the application
used to create it and the document itself. If the Mac OS doesn’t know
what application created it (and gives you an error message), you can
use drag and drop in the Dock to help you open the document. You can
drag a document icon in the Dock on an application icon. If a document
is stored in the Documents folder, you can click the Documents folder
in the Dock and then click the document in the stack list to open it.

Opening Applications
and Files

Open Recently Used
Applications and Files

Click the Apple menu, and then
point to Recent Items.

Click the recent application or file
under the Applications or
Documents listing.

To clear the recent list, click the
Apple menu, point to Recent
Items, and then click Clear Menu.

Open Applications and Files

◆ Double-click the document icon.

◆ Drag the document icon to the
application icon in the Dock, either
the one that created the document
or one that will accept it. If the
application can possibly open it,
the application icon becomes
highlighted. Release the icon to
open the application and the
document.

NOTE Hold down Option+A
while you drag a document icon
into the Dock to force all applica-
tions to accept the icon. However,
an error message may result.

◆ Click the Documents folder in the
Dock, and then click a document
in the stack list.

3

2

1

Double-click to open

Drag icon onto an accepting application icon to open

Blank icon; no association

1

2

3

Documents folder



The Dock is initially located at the bottom of the desktop and is most
often used to launch an application or switch from one application to
another. When you launch an application, its icon appears in the Dock
with a black arrow below it. If an application is not available in the
Dock, you can hide any open applications to display the desktop, open
your hard disk, and then launch the application you want. If you
arrange open application windows so that they are visible, you can
switch among them simply by clicking in the window in which you want
to work.
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Switching Between
Applications

Hide and Show an Application

Click the application menu.

In this case, the Chess menu.

Click Hide application name to
hide the application.

TIMESAVER Press A+H to
hide the application.

Point to the bottom of the screen
to display the Dock. You’ll see the
hidden application in the Dock.

To show the application, click the
application icon in the Dock.

Hide Other Applications

Click the application menu, and
then click Hide Others.

TIMESAVER Press Option+
A+H to hide all other
applications.

1

4

3

2

1 1 2

1
Did You Know?

You can bring forward an application
and its windows and hide all other
applications. Hold down Option+ A,
and then click the program icon in the
Dock.
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Switch Between Applications

Mac OS X provides several ways to
switch between applications:

◆ Click a visible window in the other
application.

◆ Display the Dock, and then click
an application icon to show (black
triangle below icon) or launch the
application.

◆ Press and hold down A, and then
repeatedly press the Tab key to
highlight the Dock icon of an open
application. (Use Shift+A+Tab to
move backwards) Release both
keys when you reach the one you
want to open.

To leave without switching
applications, press the Esc key.

TIMESAVER Press A+Tab
once to open the application you
used most recently. This is very
useful when you are switching
between two applications.

◆ Press F11 (use Exposé) to hide all
open windows, double-click the
hard disk icon, open the
Applications folder, and then
double-click an application icon.

Click menu to hide application Click window to switch

Double-click
to open and
locate
application
to launch

Click icon in the Dock to switch

Did You Know?
You can quickly switch between win-
dows within an application (including
the Finder). Repeatedly press A+~
(the Tilde key to the left of the number
1 key) to cycle through open windows
in the application. Release both the
keys to display the window you want.
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When you’re done working with an application, you should exit, or
close it, to conserve your computer’s resources. If an application stops
responding while you work, Mac OS X provides you with the option to
end the task. When you end a task, you’ll probably lose any unsaved
work in the problem application. If the problem persists, you might need
to reinstall the application or contact product support to fix the
problem.

Quitting Applications

Quit an Application

Click the application menu.

In this case, the Chess menu.

Click Quit application name.

TIMESAVER Press A+Q to
quit an application.

If necessary, click Save to save
your changes.

Quit an Application That is 
Not Responding

Click the Apple menu, and then
click Force Quit.

TIMESAVER Press A+
Option+Esc to force a quit.

Click the application name you
want to force a quit.

Click Force Quit.

Click Force Quit again to confirm
you want to force a quit. 

Click the Close button.5

4

3

2

1

3

2

1
1 2

5

2

3
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CHECKMATE, oh how I love to hear those words, or at least when I'm
the one saying them. Computers aren’t just for business proposals,
worksheets, and documents. We all know that there are thousands of
games available for computer systems, but one of the most challenging
games in the world is available as soon as you load Mac OS X. Chess is
available in the Applications folder and ready for you to play on your
own screen. Chess gives you more options, and even makes it quite a
challenge to those who have moved beyond the beginner stage.

Playing Chess

Play Chess

Click the Applications folder in the
Dock, and then click the Chess
icon.

Click and drag a piece. For
example, the white Knight at G1 to
F3.

Black responds with a move. 

Click the Moves menu, and then
click Take Back Move, Show Hint,
or Show Last Move.   

Click the Chess menu, and then
click Preferences. Select from the
following options:

◆ Click the Board pop-up to
select a new playing surface.

◆ Click the Pieces pop-up to
select different playing pieces.

◆ Select the check boxes for
Speech to use voice
recognition to call your moves.

◆ Drag the Computer Plays slider
to increase or decrease the
computer's playing skills.

◆ Select the Show Move in Title
check box to display the
current move in the Title bar.  

Click the Close button.

Click the Game menu, and then
select a game option, such as
New Game or Save Game.

Quit Chess.8

7

6

5

4

3

2

1

2

5

6



When you work with Address Book, you have the ability to create cards
of information. Each card can hold all the information you want to keep
on a contact, no matter how many phone numbers and e-mail
addresses a particular friend, or company might have. In addition, you
can add a picture with a drag and a drop. Address Book comes pack-
aged with a bunch of features such as: label generation, change of
address notification, synchronization with MobileMe, Google Contacts,
or Yahoo Address Book, view iChat Buddy status, and even the ability
to use speech recognition to look up and search the Address Book
database. Creating an Address Book involves launching Address Book,
and then working through the simple setup procedures.
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Creating an Address
Book

Create an Address Book

Click the Applications folder in the
Dock, and then click the Address
Book icon.

Click the Add Group (+) button  to
add a group.

Give the new group a descriptive
name, and then press Return.

Click the Add Name (+) button to
add a new card.

Type a Name, and then using the
Tab key, type a Company Name
(if necessary).

5

4

3

2

1
53

42

Did You Know?
You can share your address book
online. If you have an MobileMe
account, you can share your address
book online with contacts and syn-
chronize across all your Macs. Click
the Address Book menu, click
Preferences, click Accounts, select the
Synchronize with MobileMe check box,
click MobileMe, click the Sync tab,
select the Contacts check box in the
list, then click the Close button. You
can also set options to synchronize
with Yahoo or Google. In addition, you
can search for contacts and addresses
on a Mac OS X, Microsoft Exchange
2007, or LDAP servers.
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Click in the individual card fields to
add information such as: Phone
number, e-mail address, home
address, Internet home page, and
Instant Messaging user name (a
MobileMe or AIM screen name).

If you enter an IM or AIM user
name, you can view iChat Buddy
status while browsing contacts in
the Address Book.

If necessary, click the Remove
button (-), located to the left of
some of the data fields to remove
that field.

Click in the Note field to add
specific text notes.

If necessary, click on the Field
pop-up to change the field name. 

Repeat steps 4 thru 9 to add
additional address cards.

Quit Address Book.11

10

9

8

7

6 7

8 6

9

Did You Know?
You can archive your Address Book
data. If your Address Book data is
important, you can back up the data in
case of a catastrophic failure. Open
the Address Book application, click the
File menu, point to Export, and then
click Address Book Archive. The file
name comes with the date of the
archive. All you have to do is select
where you’d like to save the archive,
and then click Save. To restore the
data, click the File menu, point to
Import, and then click Address Book
Archive. Select the file with the correct
date, and then click Open.

Importing Contacts into Address Book 

Address Book creates and reads vCards, the standard method of
exchanging data between applications. If you have vCards in another
application, such as an e-mail application, you can import or export
addresses with Address Book. To create a vCard, drag an address card
out of the Address Book window. You can drag individual vCards in and
out of the Address Book window. To import a set of vCards, click the
File menu, point to Import, click vCards, select the file that contains the
exported addresses, click Open, and then click OK (if you’re updating
contact information, click Review Duplicates to reconcile any con-
flicts). To see the last batch of addresses you added to Address Book,
click Last Import in the Group column. 

For Your Information



Once a contact is placed within the Address Book, it’s a simple matter
to edit or add information concerning a contact. The Address Book
automatically saves the information as you change it, so there's no
need to stop and save your work. Editing or updating an Address Book
contact involves the same skills learned in creating a contact, with the
exception that the information is already there, so all you need to do is
edit, add, or delete the contact.
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Editing an Address
Book

Edit an Address Book

Click the Applications folder in the
Dock, and then click the Address
Book icon.

Select the Group that contains the
contact or contacts you want to
modify.

Select the Name from the
available cards in the Group.

Click Edit.

IMPORTANT The Edit button is
a toggle button, and once it’s
clicked, you’ll be in edit mode for
any selected name.

4

3

2

1 2 3

4

Did You Know?
The Address Book application remem-
bers your location. When you open the
Address Book, it loads the Group that
you had last used.

You can move contacts in your
Address Book. Open the group, and
then drag the contact from the open
group to the new group.
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Click in any of the fields to edit the
existing information.

Click the Remove (-) button to
remove a specific data piece.

Click the Add (+) button  to add an
additional data piece.

To remove a contact from the list,
select a contact in the Name
column, press the Delete key, and
then confirm your delete.

Quit Address Book.9

8

7

6

5

8

6 7 5

Did You Know?
You can undo mistakes in the Address
Book. If you accidentally delete a con-
tact, don't worry, just click the Edit
menu, and then click Undo Delete
Record. The Address Book comes
equipped with multiple undos.

You can let the Address Book read a
contact to you. Control-click an item in
the contact window, point to Speech,
and then click Start Speaking. To end
the audio, Control-click, point to
Speech, and then click Stop Speaking.

You can search for Address Book info
in Google or Spotlight. Control-click a
searchable item (such as name or
phone) in the contact window, and
then click Search in Google or Search
in Spotlight. 

Printing from the Address Book 

Address Book makes it easy to print a mailing list or print labels. The
expanded Print dialog provides options to select a printing style and
specify the specific fields from the Address Book you want to include
in the printing. To print a mailing list or labels from Address Book, click
the File menu, click Print, select a printer from the pop-up, select Lists
or Mailing Labels from the Style pop-up, select a paper size from the
pop-up, select an orientation, select or clear the attributes (fields) to
display the information you want (such as phone, e-mail, address,
Instant Messenger, photo, job title, etc.), select a font size from the
pop-up, specify the number of copies, preview the results in the left
pane, and then click Print.

For Your Information



Any address book, even Snow Leopard's, can quickly become a con-
fusing mess of unorganized data. Unlike paper address books, Snow
Leopard's can create a very organized system… if you know what to
do. For example, you could create logical groups, and then use obvious
naming conventions for each contact. You can name your groups by
family, school, work, community service, kids sports teams just to name
a few.  Address Book has many features that helps you manage your
groups and the contacts you create, and then share them with others.
You can even use the vCard format to exchange contact information
between various programs or set up synchronization and sharing with
MobileMe, Google Contacts, or Yahoo Address Book (New!).
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Managing and Sharing
an Address Book

Manage an Address Book

Click the Address Book menu, and
then click Preferences.

Click General to organize the
viewable screen. 

Make any of the following
changes: Display Order, Sort By, 
Address Format, and Font Size. 

Click Accounts to synchronize and
share your Address Book.

Click the Account information tab
to set options to use MobileMe,
Yahoo!, or Google (New!).

Click the check box for the
account you want, click the
MobileMe or Configure, and then
follow the step by step instructions
to use MobileMe, Yahoo!, or
Google.

Click the Sharing tab to set option
to share your address book.

Select the Share your Address
Book check box.

Click the Add (+) button, select the
contacts with MobileMe accounts
you want to have access.

Click Send Invitation to inform the
contacts they have access.

10

9

8

7

6

5

4

3

2

1
2

3

4

6

5 7
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Click Template to organize the
card data screen. 

Make any of the following
changes: Work and Mobile phone
numbers, Email and Homepage
information, Names, and Work
address.

Click Phone to set the format for
the phone number entry.

Click the Formats pop-up, and then
select a phone number format.

Click vCard to set the preferences
for vCards.

Make any of the following
changes: vCard Format, vCard 2.1
Encoding, Enable Private ‘Me’
Card, Export Notes in vCards, and
Export Photos in vCards.

Quit Address Book.17

16

15

14

13

12

11

15

16Did You Know?
You can notify contacts of changes to
your address book information. Create
a group of addresses, click the File
menu, click Send Updates, select the
group or groups you want to notify,
type a subject and message, and then
click Send.

You can subscribe to an address book.
Click the File menu, click Subscribe to
Address Book, enter the MobileMe e-
mail address of the user you want, and
then click OK.

You can exchange contacts in your
Address Book with other Mac users.
Select a contact, click the File menu,
and then click Export vCard. 

Using Directory to Share Information

Directory is an application, located in the Utilities folder, that allows
you to share information about people, groups, locations, and
resources within your organization. If you have access to your organi-
zation’s directory server or Active Directory, you can configure
Directory and authenticate your personal information using the
Directory Utility in the Utilities folder. You can create shared contacts
from your Address Book, use e-mail addresses to send e-mail using
Mail, use names to chat in iChat, or load group Web services in Safari.

For Your Information

11

12

Click to add additional
contact fields.

13



It's not unusual for an address book to grow quite large. Over time,
you’ll add more and more addresses and occasionally delete old ones,
until you have dozens even hundreds of contacts listed in your address
book. Sometimes, identification requires more than just a name or an
address, so Apple gives you the ability to add an image to a contact.
Maybe it's to help associate a face with a name, or just be reminded
(visually) of a special someone—whatever the reason, adding an image
is as simple as opening the file containing the image, and dragging it
into the photo box for the selected contact.
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Adding an Image to 
an Address Book

Add an Image to an 
Address Book

Click the Applications folder in the
Dock, and then click the Address
Book icon.

Select the Group which contains
the contact.

Select the Name of the contact
that you want to add the image to. 

Drag the image into the active
contact.

Address Book opens an image
placement dialog which lets you
resize the image to fit in the
allocated space.    

Drag the slider left or right to
resize the image.

Click Set to add the image to the
contact.   

Quit Address Book.7
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Photo
box

Click to use
your Web cam. 

Did You Know?
You can add instant pictures to an
address contact. Double-click the
photo box, and then click the Take
Video Snapshot button. If you have a
Web cam attached to your computer,
you can then take an instant snapshot
based on anything the camera sees.
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Grapher is an application, located in the Utilities folder, that allows you
to graph mathematical functions and equations, so you can visualize
what’s happening. You can analyze equations and display algebraic
relationships. With Grapher, you can create two- and three-dimensional
graphs and format the results to get the visual display you want. 

Performing Graph
Calculations

Create a Graph with Grapher

Click the Applications folder in the
Dock, click the Utilities folder, and
then click the Grapher icon.

Click the 2D Graph or 3D Graph
tab.

Select the type of graphic you
want to create. 

Click Choose.

Enter the expression in the entry
field.

TIMESAVER To see an
example, click the Examples menu,
and then select an example.

To format the graph text, layout,
axes and frame, use the Format
menu.

Click the File menu, and then click
Save As.

Select the drive and folder in
which you want to save the file.

Type a name for the file, and then
click Save.

Quit Grapher.10

9

8

7

6

5

4

3

2

1

43

2

6

5
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Mac OS X comes with a great tool to help you perform common calcu-
lations and to do complex conversions. The Calculator application has
been around for a long time, however, Mac OS X gave it a few powerful
features, that just might make you want to reacquaint yourself with an
old friend. If you're like most people, you probably have a dozen calcu-
lators laying about your home and office. If you’re tired of all the mess,
then take a look at the Mac's idea of a calculator. Not only does it help
you add 2 + 2; it helps you convert miles into kilometers or the Euro dol-
lar into American currency. The Calculator application gives you the
ability to perform conversions on everything from currency to volume,
from temperature to speed, and more.
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Performing
Calculations and
Conversions

Work with the Calculator

Click the Applications folder in the
Dock, and then click the
Calculator icon.

Click the buttons on the calculator
to perform standard calculations.

Click the Window menu, and then
click Show Paper Tape to display
a Paper Tape dialog, which shows
all of your calculations. 

Click Clear to clear the tape, or
click Recalculate Totals to have
the calculator refigure the total.   

Click the File menu, and then click
Print Tape to have a paper copy of
your calculations.

Click the View menu, and then
click Scientific to have access to
a scientific calculator.

Quit Calculator.7
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Did You Know?
You can use the keypad with the
Calculator. If you have a 10-keypad,
instead of trying to click the calculator
buttons, just use the keypad. The
Calculator automatically reads the key-
pad objects, and display the results in
the calculation window. 
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Work with Conversions

Click the Applications folder in the
Dock, and then click the
Calculator icon.

Enter a value into the calculation
window.

Click the Convert menu, and then
click Currency.

Click the Convert pop-up, and then
click Currency. If you need to
change the convert type, click the
Convert pop-up and make your
change.

Click the From and To pop-ups to
select currency countries.   

If available, click Update Currency
Rates to access the latest
exchange rate (requires an
Internet connection).

Click OK.

The conversion results display in
the calculation window.

Quit Calculator.8
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Did You Know?
You can save calculation results in
memory. Click the M+ (memory add)
button to save a calculation result or to
add a calculation result to the value
residing in memory. At any time during
the calculation, if you want to use that
result, click the MR (Memory Recall)
button and the number reappears. In
addition, you can use the M- (memory
subtract) to subtract a displayed result
from the value in memory, or the MC
(Memory Clear) button to clear out the
memory.

6



Mac OS X has provided you a way to directly access your digital cam-
era and organize your images and even sounds. Just plug in your digital
camera or scanner directly, and import your pictures or sounds from
any application that supports Services and Rich Text Format (most digi-
tal cameras and scanners). The Image Capture application lets you
download all or selected contents from your digital camera, crop
images to a variety of sizes, and even delete unwanted pictures from
your camera. You can even use Image Capture to build a Web page,
complete with individual thumbnails of your photos. Just click Build
Web Page from the Automatic Task pop-up on the toolbar. Image
Capture automatically generates the Web page and stores the images
in the Pictures folder on your hard drive. In addition, you can use the
images to create a slideshow or format them for printing. 
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Capturing Images with
a Digital Camera

Capture Images with a 
Digital Camera

Plug a digital device into your
computer.

If necessary, click the
Applications folder in the Dock,
and then click the Image Capture
icon.

Click the Download To pop-up, and
then select where to store the
images.

Click the Automatic Task pop-up,
and then select from the tasks.

Click Options, select from the
available options, and then click
OK.

Click Download All to move all the
images from the digital device to
the folder on your hard drive.

Click Download Some, and then
select the images (hold down A
to select more than one).

Click Rotate Left, Rotate Right, or
Delete buttons to adjust or delete.

Click Download.

Quit Image Capture.10
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If there is something on your computer screen, such as an error dialog,
window, or desktop, that you want to capture as a picture to show
someone, you can use a built-in utility called Grab to get the job done.
Grab is useful for taking pictures of different parts of the screen, like
the ones in this book. This may not be a tool you’ll use everyday (unless
you are a computer trainer or book author), but it may come in handy
one day.

Capturing Screen
Shots with Grab

Capture Screen Shots with Grab

Display the screen you want to
capture.

Open the Applications folder, open
the Utilities folder, and then
double-click the Grab icon.

Click the Capture menu, and then
select the command with the
method you want to use: 

◆ Selection. Drag to select a
capture area.

◆ Window. Click the Choose
Window button, and then click
a window.

◆ Screen. Click a screen.

◆ Timed Screen. Click the Start
Timer button, display a screen,
and then wait 10 seconds.

Click the File menu, and then click
Save As.

Select the drive and folder in
which you want to save the file.

Type a name for the file, and then
click Save.

Quit Grab.7
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Screen method 

Selection method 

Timed Screen method

Window method

Did You Know?
You can show a pointer in a screen
capture. Click the Grab menu, click
Preferences, click a pointer type or the
blank one for no pointer, and then click
the Close button. 



Need a quick way to view images, or possibly a Portable Document File
(PDF)? No problem, Snow Leopard's built-in PDF viewer, Preview, lets
you quickly view graphics and PDF files with the click of a button. In
fact, once you've opened a PDF document file, Preview lets you perform
an improved indexed search (New!), select text (New!) and copy it to
the clipboard, even view FAX documents using its built-in FAX support.
The Preview application works to open any images or documents, which
are not identified by another program, regardless of type. For example,
double-clicking on a Photoshop document file (.psd) would open the
image in Photoshop. However, if you double-click on a graphic file from
your digital camera, chances are it would open in the Preview applica-
tion. And the same would be true of a PDF document, if you owned
Adobe Acrobat, or the Acrobat Reader application. When you open a
PostScript or EPS (Encapsulated PostScript) file, Preview converts the
file into the PDF format. You can open multiple PDFs in a single docu-
ment window or import scan images in Preview (New!). You can also
open and view multiple image files as a contact sheet (New!). If you
want to adjust image size, you can use the Adjust Size command on the
Tools menu for high-quality results (New!). If you want to add com-
ments or annotations to a PDF, you can get easy access to the tools you
need by using the Annotation toolbar (New!). If you want to see how
images appear when printed, on the Web, or on a printing press, you
can use Soft Proof with Profile to simulate the results (New!).
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Previewing Images
and PDF's

Set Preview Preferences

Click the Preview icon in the Dock.

Click the Preview menu, and then
click Preferences.

Click any of the following icons to
set Preview preferences: 

◆ General. Sets options to open
files in a single or separate
windows.

◆ Images. Sets options for
scaling images. 

◆ PDF. Sets options to for scaling
PDFs, opening and viewing
documents, and annotations.

◆ Bookmarks. Allows you to
remove bookmarks.

Click the Close button.4
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34

PDF preferences
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Preview Images and PDF's

Click the Preview icon in the Dock.

Click the File menu, click Open,
select one or more document or
image files, and then click Open.

Click the Sidebar button to 
display it, if necessary.

To change the Sidebar display, click
a view tools button:

◆ Contact Sheet. Displays full page
of thumbnails.

◆ Thumbnails. Displays mini-
images of the documents.

◆ Table of Contents. Displays
document titles.

◆ Annotations. Displays a list of
annotations.

To move between pages in a PDF
document or another document,
click the Previous or Next buttons
or click an item in the Sidebar.  

To increase or decrease the viewing
size of the image, click the Zoom In
or Zoom Out buttons.

To select a portion of a document or
image, click a selection tool button
(Move, Text, Select, or Select
arrow), and then drag to select it.

◆ To copy the selection, click the
Edit menu, and then click Copy.

To modify a selected image, click
the Tools menu, and then click
Adjust Size or Adjust Color.

To draw or add notes on the
document, click the Annotate button
to display the Annotation toolbar
(New!), and then use the tools. 

To print, display the document or
select a portion of it, click the File
menu, and then click Print.

Save the document,and then quit
Preview.
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Using PDFs
The PDF (Portable Document File) format is the way to save and
move documents between computers and operating systems. Do you
need to send a document to several people, and you're not sure if
they're using a Macintosh or Windows machine? Do you want the
document to be viewed exactly as you created it? Then the PDF for-
mat is the way to go. Adobe's Portable Document File has literally
swept the computer industry (Mac, Windows, and UNIX); allowing
you to combine text and graphics into a format that can be viewed
by literally anyone who has the Preview application (on Macintosh),
or the Adobe Acrobat Reader application (available free from
www.adobe.com). As a matter of fact, the Acrobat Reader is shipped
with every computer, regardless of model or operating system.

For Your Information

Sidebar

4

9

Annotation toolbar

3

www.adobe.com


The Sticky Notes application is not new to Snow Leopard, however it
does give you the ability to tack notes onto your desktop; where they
stay until removed. Just think, no longer do you need to worry about the
sticky note on your monitor losing its “stick” and falling off. You can use
your desktop the way Apple intended—to help with everyday life. Once
you create a sticky note, you can change the color of the note, change
the color and size of the text, or even have your sticky note talk to you
by turning on the speech mode through the Edit menu. 
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Creating Sticky Notes

Create Sticky Notes

Click the Applications folder in the
Dock, and then click the Stickies
icon.

When you first open the Stickies
application, you’ll see 3 pre-
written stickies notes.

Click the File menu, and then click
New Note.

Type the text into the note area.

To increase or decrease the note
size, drag the lower-right corner of
the sticky note.   

Click the Font menu, and then
select from the font options. 

Click the Note menu, and then
select between Floating Windows
or Translucent Windows.

To change the color of the
selected note, click the Color
menu and make your change.

Click the File menu to import or
export notes, archive your notes,
and to print or save your notes. 

Click the Close button to quit
without saving. 

Quit Stickies.10

9

8

7

6

5

4

3

2

1

9

3

4

1



Most of us have fonts…a whole lot of fonts and Snow Leopard adds to
it (New!): Hiragino Sans GB, Menlo, Chalkduster, and Heiti. Mac OS X
organizes fonts into main folders: User and Computer. Fonts in the User
folder reside in your Home folder for private use, while fonts in the
Computer folder are available for all users. Besides these folders, you
can also organize your fonts into specific user-defined folders, known
as collections, and then activate those folders, or specific fonts within
the folder without having to restart your application. In addition, Font
Book gives you a window to view the font, and change its viewing size.
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Managing Fonts with
Font Book

Manage Fonts with Font Book

Click the Applications folder in the
Dock, and then click the Font Book
icon.

Click the Add Collections (+)
button, type a name, and then
press Return.

Click the Add Fonts (+) button.

Select the fonts you want to add to
the New Collection (active folder).

Click Open.

Select a collection from the
Collection column, and then click
on a font to view a sample.

To increase or decrease the view
of the font in the window, drag the
view slider up or down. 

To copy a font, click and drag a
font from the Font window into
another Collection.

If necessary, type search criteria
to locate specific fonts.

To remove a font from a Collection
(this does not delete the file from
the hard drive), select a font, and
then press the Delete key. 

Quit Font Book.11
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Once you've created a series of font collections, it’ll be necessary to
instruct the Font Book application as to what fonts you want to use, and
what fonts you want to turn off. It's important to understand that fonts
consume memory on your computer. For example, if you have hundreds
of fonts active (and that's not unusual), it takes more RAM memory to
maintain those fonts; even if you're not using them. That's where font
management comes into play. Using Font Book, you can decide what
fonts you need, and what fonts can be retired, or disabled, for the
remainder of the work session.
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Activating,
Deactivating, and
Customizing Fonts

Activate and Deactivate Fonts

Click the Applications folder in the
Dock, and then click the Font Book
icon.

To deactivate a collection or a
font, select the collection or font,
click Disable, and then click
Disable to confirm.

IMPORTANT The Enable
button is a toggle, when a font is
active, it displays the word
Disable, and when a font is
disabled it displays the word
Enable.

To activate selected fonts, select
one of more fonts from the Font
column, and then click Enable.

If a font is disabled, it says Off to
the right of the font.

Quit Font Book. 4
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1
Font window

Selected font2

Disabled
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Did You Know?
You can find duplicate fonts. If a dot
appears next to a font family, it means
you have a duplicate. You can correct
the problem by disabling the one you
don’t want. Select the version you
want, click the Edit menu, and then
click Resolve Duplicates.
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Customize Fonts

Click the Applications folder in the
Dock, and then click the Font Book
icon.

Select the font you want to
customize.

Click the Preview menu, and then
click Custom.

Control-click your mouse in the
font window, point to Font, and
then select from the following
customizing options:

◆ Show Fonts. Lets you adjust the
font; including color, size and
drop shadow.

◆ Show Colors. Lets you change
the color of the selected font. 

Make any changes to the font, and
then close any open dialogs.

Quit Font Book. 6
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Fonts
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Did You Know?
You can locate a font on your com-
puter. Select the font, click the File
menu, and then click Reveal In Finder.
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Dashboard is a Mac OS X screen that gives you quick access to widg-
ets, such as news headlines and updates, slide shows, weather infor-
mation, traffic maps, Internet radio streams, and slide shows of online
photo albums. Widgets are mini-applications that can connect to Web
services, such as an RSS feed (which automatically delivers Web con-
tent to your desktop), or integrate with many of your applications, such
as viewing your calendar. You can customize Dashboard to suit the way
you work by using the Widget bar. Mac OS X comes with a set of widg-
ets to get you started. However, you can easily download more widgets
online. You can quickly open Dashboard by pressing the F12 key. If you
prefer a different shortcut key, you can select the one you want in the
Exposé & Spaces pane of System Preferences.

Working with
Dashboard

Work with Dashboard
◆ Show or Hide Dashboard. Press

F12.

◆ Open Widget Bar. Click the Open
(+) button in the lower-left corner
of Dashboard or press A+=
(equal).

◆ Close Widget Bar. Click the Close
(x) button or press A+= (equal).

◆ Scroll the Widget Bar. Click the
Left or Right Arrow buttons or
press A+Left Arrow or A+Right
Arrow.

◆ Reload Current Widget. Press
A+R.

Click to open widget bar

Dashboard widgets

Did You Know?
You can make widgets available to all
users. Move or copy the widget into
the Widgets folder in the Library folder
for your computer from the similar
Library folder in your Home folder. All
the Mac OS X pre-installed widgets are
stored in the Widgets folder for your
computer.
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Change Dashboard Preferences

Click the Apple menu, and then
click System Preferences.

Click the Exposé & Spaces icon.

Click the Exposé tab.

Click the Hide and Show pop-up,
press a keyboard modifier (Shift,
Control, Option, or A) if you want,
and then select the shortcut key
you want.

If you want to see more shortcut
options, hold down the Shift,
Control, Option, or Command keys,
or a combination of the keys, while
you view the pop-up menu.

If you have a Mighty Mouse or
other multi-button mouse, you can
use the other pop-up to set mouse
button shortcuts.

On the Mighty Mouse, Button 3
applies to the scroll-ball button
and Button 4 applies to the pair of
side buttons. You can use the
scroll-ball button to open
Dashboard.

Click the Close button.6
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Did You Know?
You can update all your Macs with
widgets using .iMac. With an .iMac
account, you can use Dashboard sync-
ing to automatically update all the
widgets on all your Macs. Click the
System Preferences icon on the Dock,
click the .iMac icon, click the Sync tab,
select the Synchronize With MobileMe
check box, select the Dashboard
Widgets check box, and then click the
Close button.
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Dashboard comes with a wide variety of widgets pre-installed with
Mac OS X Snow Leopard. Dashboard displays the Calculator, Weather,
World Clock, and iCal widgets by default. However, you can add other
pre-installed widgets to the Dashboard, which include Address Book,
Business, Dictionary, ESPN, Flight Tracker, Google, iTunes, Movies,
People, Ski Report, Stickies, Stocks, Tile Game, Translation, and Unit
Converter. In fact, you can add more than one of the same widget, such
as two World Clocks for two different times around the world. Some of
the widgets are linked with applications and allow you to access infor-
mation or functionality without opening the application. For example,
the Weather widget displays Web-based content on the Dashboard
without opening a Web browser.

Using Dashboard
Widgets

Show or Hide Widgets on the
Dashboard

Press F12 to open Dashboard.

Click the Open (+) button in the
lower left corner to display the
Widget bar.

To hide a widget from the
Dashboard, click the Close (x)
button in the upper-left corner of
the widget.

TROUBLE? If you don’t see a
Close button, press Option and
move the pointer over the widget.

To show a widget on the
Dashboard, click the widget you
want on the Widget bar. 

To move a widget on the
Dashboard, drag it to another
location.

Click the Close (x) button in the
Widget bar.
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Toggles between (t) and (x).
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Use Pre-installed Widgets
◆ Address Book. Type a name, or

click the arrow buttons.

◆ Business. Type a business name
or category. Click the Info (i)
button to change the local city. 

◆ Calculator. Use the numeric pad or
click buttons to enter numbers.

◆ Dictionary. Type a word to view a
definition.

◆ ESPN. Click the Info (i) button to
select a sport. Click New or
Scores to change the display.

◆ Flight Tracker. Enter flight informa-
tion, and then click Find Flights.

◆ Google. Type a word or phrase,
and then press Return to display
the Google search.

◆ iCal. Use the arrow buttons or
arrow keys to move around the
calendar. Click the today’s date
pane to expand/collapse it.

◆ iTunes. Use controls to use iTunes
when it’s open.

◆ Movies. Click the Info (i) button to
enter your zip code to view
theaters near you.

◆ People. Type first name, last name,
and a city and state or zip code,
and then press Return.

◆ Ski Report. Click the Info (i) button
to type the name of a resort.

◆ Stickies. Type notes. Click the Info
(i) button to change color and font.

◆ Stocks. Type a company. Click the
Info (i) button to view a graph.

◆ Tile Game. Click a tile that borders
the empty space to move it.

◆ Translation. Select a language,
and then type the word or phrase.

◆ Unit Converter. Select a Convert
category, select the unit converted
and the unit converted to. 

◆ Weather. Click the Info (i) button to
check the weather forecast.

◆ World Clock. Click the Info (i)
button to change the city.

iCal calender

Calculator Weather World Clock

Click to scroll through
available widgets

Click to scroll through
available widgets
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Even though Mac OS X comes with a wide range of commonly used
widgets, there is always room for more. Developers are continually cre-
ating new widgets, which you can download from the Internet and
install onto your computer. If you no longer use a widget on the
Dashboard, you can remove a pre-installed widget from the Widget bar
or remove a widget you installed from your computer.

Adding and Removing
Dashboard Widgets

Install a Dashboard Widget

Press F12 to open Dashboard.

Click the Open (+) button in the
lower left corner to display the
Widget bar.

Click Manage Widgets.

Click More Widgets.

Browse the widget Web site to
find the widget you want to
download and install.

Click the widget’s Download
button.

The installer should automatically
start. If it doesn’t, double-click the
downloaded file. If the file is
compressed, you need to
uncompress it first. 

Click Install.

Click Keep to keep the widget or
click Delete if you decide not to
keep it.

Click the Close button.9
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Remove a Dashboard Widget

Press F12 to open Dashboard.

Click the Open (+) button in the
lower left corner to display the
Widget bar.

Click Manage Widgets.

To remove (disable) a widget from
the Widget bar, clear the check
box next to the widget name you
want to remove. 

To remove a widget you installed,
click the widget’s Remove (-)
button, and then click OK.

To close a widget from the screen
and remain in the Widget bar, click
the Close (x) button.

Click the Close button.7
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Did You Know?
You can customize a widget. When
you point to a widget on the Dashboard
and a small info (i) button appears, you
can customize the widget. Click the
small info (i) button to display the set-
tings you can change. The available
options vary depending on the widget.

You can sort widgets on the Widget
bar. Press F12, click the Open (+) but-
ton, click Manage Widgets, click the
Sort pop-up, click Sort By Name or
Sort By Date, and then click the Close
button.

6
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You can also create your own widgets by using Web Clips or Dashcode.
A Web Clip widget is a container for a Web page you can add to the
Dashboard. When you open the Web Clip widget in Dashboard, the
Web page associated with it opens. If you’re a developer with a basic
knowledge of HTML, JavaScript, and CSS, you can create your own
Dashboard widget using Dashcode. Dashcode is out of the scope of
this book. For more information on Dashcode, go to the Apple
Developer Connection Web site.

Creating a Web Clip
Dashboard Widget

Create a Web Clip Dashboard
Widget

Launch Safari, and then display
the Web page you want to make
into a Web Clip widget.

Click the File menu, and then click
Open in Dashboard.

Move the page to highlight the
area you want to use, and then
click the mouse button.

To reposition the highlighted area,
drag the area. To resize it, drag the
circular handles on the edges of
the box.

Click Add.

To customize the widget, point to
it, click the small info (i) button,
and then specify the options you
want:

◆ Edges. Displays thumbnails of
different edge styles. Click the
style you want.

◆ Only Play Audio in Dashboard.
Select or clear the check box
to play or not play audio in
Dashboard.

◆ Edit. Click to select a different
highlighted area.

When you’re finished, click Done.7
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faxes, addressing, 214, 218
iChat buddies from, 296
images, adding, 144
managing contacts, 142
MobileMe Address Book, 350-351
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sending e-mail from, 266-267
sharing, 142-143
Smart Addresses, using, 266
Spotlight searches, keywords for, 57
subscribing to, 143
vCards, 139, 142-143

Administrator, 386

file permissions, setting, 390
master password, restoring, 398-399
Safari preferences, setting, 253
in Simple Finder, 94

Adobe Acrobat. See also PDF files
downloading, 209

AIM, iChat with, 289, 291
AirPort

Admin Utility, 430
configuring connection, 220
desktop icon, 5
iChat with, 308
with Mac for Windows, 465, 472
making Internet connection with, 226
multiple connections with, 221
network port configuration for, 225
printers, sharing, 202-203
setting up, 224

AirPort Extreme Base Station, 481
alerts

changing sounds, 114
forms, sending nonsecure, 243
iChat notification alerts, 312
speaking voice for, 118

Alex
default speaking voice, setting, 118
interface options, setting, 119
for VoiceOver, 122

aliases, 77, 395
creating, 90-91

alignment
of document text, 178
of e-mail message text, 269
of tables, 185

AND operator, searching with, 57
animated GIFs

creating, 297
movies as animated GIFs, exporting, 331
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anti-aliasing, 100-101
Anywhere mode, 168
AOL and iChat, 219, 289-290
appearance options, changing, 100-101
Apple Account number for iTunes Music

Store, 318
Apple Background, 102
Apple Developer Connection Web site, 162
Apple Events, sharing, 405
Apple Mighty Mouse, 6

Dashboard preferences, changing, 157
with Mac for Windows, 472

Apple Remote, 465. See also Front Row
iPod Hi-Fi, 313
with Mac for Windows, 465, 472

AppleScripts, 130
with Automator, 512
basics of, 507
displaying Script menu, 508
example Scripts folder, opening, 509
opening from Scripts menu, 511
ready-make AppleScripts, using, 508-509
recording, 510
writing, 510

AppleTalk printers, installing, 198-199
applications, 1, 129. See also aliases; third-

party applications
different program, opening documents

with, 29
icons, 10
Info window, information in, 50-51
installing third-party applications, 131
launching, 132
list of, 130
nonresponding, quitting, 136
opening, 133
quitting, 136
showing/hiding, 134
Spotlight searches, keywords for, 57
switching between, 134-135
System Profiler, viewing system infor-

mation with, 447
Application Services, using, 436
Applications folder, 26-27
archiving. See also backing up

Address Book data, 139
Create Archive command, 435
e-mail, 281

ARPANET (Advanced Research Projects
Agency Network), 219

Arrange menu in Icon view, 32
arrows in dialogs, 9
Assist Me, help with, 407
attachments

deleting from e-mail, 277
iCal calendar event attachments, work-

ing with, 370
with instant messages, 303
in replies to e-mail, 275
saving files, 277
sending files as, 276
Spotlight results as, 63
viewing, 276-277

audio chats. See iChat
audio MIDI devices, configuring, 460-461
authentication preferences for Bluetooth,

415
AutoFill for Safari forms, 242
Automator, 130, 491

Action list, 492, 494
actions, 491

adding, 500
recording actions, 502
variables to action, adding, 501

AppleScripts with, 512
Description view, 493, 494
example workflow

modifying, 499
opening, 497
working with, 498

existing workflow, opening, 496
input and output, controlling, 499
introduction to, 492-493
Library pane, 492, 494
modifying example workflow, 499
plug-ins with, 499, 506
printing workflow, 505
recording actions, 502
running and saving workflows, 504-505
Search box, 493, 494
starting, 495
stopping workflow, 504
toolbars, 492, 494

customizing, 505
Variable list, 492-493, 494
variables to action, adding, 501
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Watch Me Do action, 502
window, parts of, 492-494
Workflow log and panes, 493, 494
Workflow variable list, 493, 494
working with workflows, 503

autosaving TextEdit preferences, 194

B
Back button on toolbar, 17
backdrops in Photo Booth, 331
backgrounds

desktop backgrounds, selecting, 102
in e-mail message text, 269
iChat window background, changing, 311

backing up, 477. See also archiving; disk
image; Time Machine

on CDs or DVDs, 490
compressed files and folders, 435
e-mail, 281
formatting, backups prior to, 438
iCal calendar, 371
to iDisk, 479
iTunes library, 327
MobileMe, backing up files, 358-359

Back to My Mac, accessing computer with,
420-421

baseline for characters, changing, 182
BBEdit, 436
BinHex format, 251
birthday calendars, 369
blocking

e-mail, 284-285
iChat buddies, 302
pop-up windows, 255

Bluetooth. See also iSync
Application Services with, 436
desktop icon, 5
with Mac for Windows, 465, 472-473
making Internet connection with, 226
moving items with, 414
Passkey with, 413
preferences, setting, 415
printers, installing, 199
setting up network, 412-413
sharing, 405

boldfacing
document text, 178

e-mail message text, 269
fonts, 155

Bonjour, 289
list of Web sites, viewing, 238
printers

installing, 198-199
sharing, 202-203

problems with, 308
saving chats, 311
starting messaging, 309
turning on, 308

bookmarks. See also Safari
with DVD Player, 333

Bookmarks Library. See Safari
Boolean operators with Spotlight search, 57
Boot Camp Assistant, 112, 465. See also

Mac for Windows
installing Windows on Mac, 468-469
preparing Mac for Windows, 466-467
removing Windows with, 474-475
upgrading from beta, 467

BOOTP (boot protocol), 223
borders for table cells, 185
bouncing e-mail, 284-285
Braille, VoiceOver supporting, 122, 125
brightness on monitor, changing, 454
broadband connection. See cable modems
browsers. See Web browsers
buddies. See iChat
bulleted lists, 184

in e-mail message text, 269
burning. See CDs; DVDs
Business, Dashboard displaying, 158-159
.bzip files, opening, 434

C
cable modems, 220

Ethernet with, 223
firewalls for, 409
sharing connection, 408

cache
for e-mail, 260
Safari cache, emptying, 236

calculations. See also Calculator
Grapher, creating graphs with, 145

Calculator, 130
conversions, performing, 146-147
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Calculator (continued)
Dashboard displaying, 158-159
working with, 146

CalDAV workplace calendar server, 372-373
calendars. See iCal; iSync
cards. See also vCards
case-sensitivity

for finding/replacing text, 176
of passwords, 3

CD-ROMs, 27
CD-Rs, 27
CD-RWs, 27, 52
CDs. See also iTunes

adding/removing files/folders from, 53
backing up files on, burning, 490
creating, 53
disk image, burning from, 488
erasing, 338
music CDs, burning, 326
preparing to burn, 52
Sidebar, burning disk with, 16
start settings, changing, 113
System Profiler, viewing information

with, 447
uneven CDs, loading, 27

Cellos voice, 118
cell phones. See also iSync

Bluetooth preferences, setting, 415
iPhones with iTunes, 325

cells in tables, 184-185
center-alignment

of document text, 178
of tables, 184

change of address notification, 138
characters

baseline, changing, 182
for file names, 42
spacing, changing, 182
special characters, inserting, 188

check boxes in dialogs, 9
check marks in menus, 7
Chess, 129, 137
children. See parental controls
Chinese handwriting, 169
cleaning up

files and folders set by clean up, 33
Icon view, items in, 32-33

clicking with mouse, 6

Clipboard
document text on, 166-167
Web page text, copying, 249

Close button for windows, 12
closed captioning in QuickTime Player, 335
closing

dialog options, 9
documents, 191
windows, 12-13

collating print output, 206
color labels

for files and folders, 40-41
for Find window searches, 67
names, changing, 41

Color Picker, selecting with, 457
colors. See also ColorSync

Color Picker, selecting with, 457
Digital Color meter, using, 456
for document text, 178
with DVD Player, 333
for e-mail message text, 269
for fonts, 155
highlight colors, changing, 100
for iChat chats, 310
for instant message text, 300-301
monitor options, 454
palettes, selecting, 457-458
printer speed and, 196
printing, matching for, 207
for quoted text, 274
of Sticky Notes, 152

ColorSync
for fax documents, 216
matching colors to device with, 458-459
for printed documents, 207

columns. See also List view; tables
windows, headings for, 12

Column view, 30
customizing window views, 82-83
keyboard options in, 37
Preview column, 37
viewing folders in, 37

Comic Book effect, 331
commands, 7. See also specific commands

Startup commands, 395, 399
VoiceOver commands, 126-127

comments
Info window options, 51
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in Keychain, 382
compatibility of hardware devices, 462
compressing/uncompressing

attachments, files for, 276
compressed files, 435
downloaded applications, 131
files and folders, 33
restoring compressed files, 435
Safari, disk images in, 251
Stuffit Expander, opening compressed

files with, 33, 131, 434
computers. See also networks

Find window searching, 66
iTunes, authorizing/deauthorizing, 314
local name, changing, 405
maintaining, 431
several computers, connecting, 418-419
stand-alone computers, starting on, 2

Console utility, viewing system messages
with, 446

contacts. See Address Book
contents, Find window searches by, 67
contextual menus, 8
conversions with Calculator, performing,

146-147
cookies, 254

deleting, 256
cool genie effect, 89
copies for printing, 206
Copy command, 44
copying. See also drag-and-drop

Automator workflows, 503
documents, text in, 167
with Exposé, 45
files and folders, 44-45
Find window files, 69
formatting, 187
hard disk, 439
icons, 10-11
ruler, 179
Sidebar, copying folders with, 16
Web page text, 249
Windows and Mac OS X, files between,

472-473
copyrights

documents, inserting in symbol in, 188
iTunes and, 321
spacing for symbol, 182

Web page text, copying, 249
Corel WordPerfect Page Setup, 204-205
Cover Flow, 30

customizing window views, 82-83
iTunes, working with music in, 317
viewing files in, 36

cover pages, creating, 207, 213
CPU activity, viewing, 445
Create Archive command, 435
credit cards

for iTunes Music Store, 317-318
for MobileMe services purchases, 344

CSS, 162
currency conversions, calculating, 146-147
Customize Toolbar dialog, 84-85
customizing

Automator toolbars, 505
Dock, 88-89
DVD Player, 333
Exposé, 92
fonts, 154-155
keyboard shortcuts, 453
QuickTime Player, 334-335
RSS feeds, 240
Safari window, 228
Sidebar, 86-87
Spaces, 93
views, 30
widgets, 161

Cut command, 44

D
Dashboard, 130

deleting widgets, 160-161
installing widgets, 160
preferences, changing, 157
pre-installed widgets, using, 158-159
showing/hiding widgets on, 158
Web Clip widget, creating, 162
working with, 156

Dashcode, 162
data detector, 171
dates and times

announcing, 105
files and folders arranged by, 33
international options, changing, 106-107
menu bar clock, using, 105
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dates and times (continued)
setting, 104-105
showing, 105
Spotlight searches, keywords for, 57
time zones, setting, 104
World Clock, displaying, 158-159

deleting. See also Dock; iChat; Mail; Safari
Address Book contacts, 140-141
aliases, 90
attachments from e-mail, 277
Automator workflows, 503
Dashboard widgets, 161
documents, text in, 166
downloaded file, 251
e-mail, 280-281
files and folders, 48
hardware devices, 463
iCal events, 370
iSync, devices from, 375
Keychain names, 381
List view, columns in, 35
printers, 198-199
print queue, job from, 211
recently used documents, 165
Safari History list entries, 236
securely deleting files and folders, 49
stacks from Dock, 19
third-party preferences, 97
toolbar icons, 85
user accounts, 389

Description view on Automator, 493, 494
design themes, 5
desktop. See also icons

backgrounds, selecting, 102
introduction to, 4-5
screen, 2

Desktop folder, 28-29
desktop printers, using, 210
Development menu, Safari, 253
Devices section, Sidebar, 16
DHCP (Dynamic Host Configuration

Protocol), 223
dialogs

closing options, 9
language options, setting, 106-107
navigating in, 9

dial-up connections, 222
Dictionary, 130, 163. See also spell and

grammar checking
adding words to, 172
AppleScript dictionary, Automator, 512
Dashboard displaying, 158-159
looking up words with, 174
parental controls, setting, 175
preferences, setting, 174-175
recent searches, viewing, 175

Digital 8 camcorders with iMovie, 342
digital cameras. See Image Capture; iPhoto
digital certificates with Keychain, 381
Digital Color meter, 456
digital hub, 365
Digital Video (DV) camcorders, 291
Directory, 130

Address Book information, sharing, 143
disabled persons. See Universal Access
disk file system, 437

activities, monitoring, 444-445
Console, viewing system messages with,

446-447
copying disk, 439
formatting disks, 438
optimizing disk, 441
problems, fixing, 440
System Profiler, viewing system infor-

mation with, 447
disk image

blank disk image as backup, 487
burning CD/DVD from, 488
creating, 486-487
restoring to disk, 489

disks. See also disk file system; hard drive
ejecting disks, 54
mounting disks, 54
opening/viewing, 26-27

Disk Utility, 52. See also backing up; disk
file system

copying disk, 439
formatting disks, 438
restoring disk images with, 489
Windows, removing, 474-475

.dmg file format, 434
DNS (Domain Name Server), 220

for modems, 222
Dock, 5. See also showing/hiding

aliases on, 90-91
applications, launching, 132
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customizing, 88-89
deleting

items, 89
stacks, 19

moving items from, 89
showing/hiding, 88

hidden Dock, displaying, 18
stacks, 19

Simple Finder, 94
stacks, 19

documents, 163. See also attachments;
Dictionary; faxing; HTML 

bulleted lists, adding, 184
character spacing, changing, 182
closing, 191
copying text, 167
corrections in, 170
creating, 164
deleting text, 166
different program, opening with, 29
editing text, 166-167
existing documents, opening, 165
file formats for, 164
files, adding, 189
finding/replacing text in, 176-177
formatting

copying/pasting, 187
text, 178

grammar-checking, 172-173
handwritten text, inserting, 168-169
hyphenation, setting, 181
icons, 10
images, adding, 189
inserting text, 166
line spacing, changing, 183
lists, adding, 184
Microsoft Word file, saving as, 164, 190
movies, adding, 189
moving text, 167
numbered lists, adding, 184
opening, 28-29
page breaks, inserting and deleting, 183
Page Setup options for, 204
paragraph indents, setting, 181
paragraph tabs, setting, 180
PDF files, saving as, 209
Plain Text files, saving as, 190-191

previewing printed documents, 208
protecting, 190
read-only files, saving documents, 190
recent documents, opening, 165
RTF file, saving document as, 164, 190
rulers, using, 179
selecting text in, 166
spacing

character spacing, changing, 182
line spacing, changing, 183

speaking text in, 175
special characters, inserting, 188
spell-checking, 172-173
styles, applying, 186-187
tables, adding, 184-185
text wrap, changing, 181
typing errors, correcting, 170
undoing/redoing actions in, 170
viewing, 28-29
Web page, opening, 230-231

Documents folder, 28-29
dots per inch (dpi), 196
double-clicking with mouse, 6
downloading. See also iTunes; Safari

Acrobat Reader, 209
deleting downloaded file, 251
disk images, 251
iChat versions, 291
installing downloaded applications, 131
MobileMe services backup, 358
printer drivers, 197
software, 432
stopping downloading of file, 251
widgets, 156

Downloads folder, 28-29
Downloads window

clearing settings, 256
working with files in, 250-251

dpi (dots per inch), 196
drag-and-drop

document text, moving/copying, 167
files and folders, copying/moving, 45

dragging
aliases, 91
with mouse, 6

drivers for printers, 197
Drop Box folder in Home folder, 47, 402
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DSL (digital subscriber line), 220
Ethernet with, 223
sharing connection, 408

DVD Player, 130, 313
browsing movies with, 332
customizing, 333
key points, creating, 333
playing movies with, 332

DVD-R and DVD-RWs, 27, 52
DVDs, 27. See also iDVD

adding/removing files/folders from, 53
backing up files on, 490
creating, 53
disk image, burning from, 488
erasing, 338
preparing to burn, 52
start settings, changing, 113
System Profiler, viewing information

with, 447
uneven DVDs, loading, 27

E
editing

Address Book contact information, 140-
141

color labels, 40
documents, text in, 166
keychains, 382-383
Smart folders, 70-71

Edit menu Undo/Redo commands, 43
editing movies, 336-337
ejecting disks, 16, 54

desktop icon, 5
ellipses (...)

full text, showing, 34
in menus, 7

e-mail. See also Mail
MobileMe mail, 348-349

embedding movies and images, 189
emoticons in instant messages, 300-301
empty Trash warning, turning on/off, 49, 81
encryption

FireVault using, 397
Keychain data, 384

entry fields in dialogs, 9
EPS (Encapsulated PostScript) files, 150
erasing CDs/DVDs, 338

Esc key, 9
ESPN, Dashboard displaying, 158-159
Ethernet. See also AirPort

configuring connection, 220
for LANs, 410
networks, 220
setting up connection, 223

Eudora mail, importing, 259
example workflow. See Automator
exporting. See importing/exporting
Exposé, 20

copying items with, 45
customizing, 92
Dashboard preferences, changing, 157
moving and copying files with, 45
space with, 21

external disks, 27

F
Fast User Switching, enabling, 396
favorites

folder, 29
style favorites, applying, 186-187

faxing, 195
Address Book, addressing faxes from,

214, 218
automatically receiving faxes, 216-217
cover pages, creating, 207, 213
receiving faxes, 216-217
scheduling faxes, 217
sending fax documents, 214-215
sleep mode, turning off, 216-217
status of fax, checking, 217

Feedback window for speech recognition,
116-117

file extensions
different program, opening documents

with, 29
for document files, 164
Find window searching, 66
renaming files, effect of, 43
showing/hiding, 81

File Info window, 390
file management, 25
file permissions

for copying and moving files, 45
setting, 390
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files, 1. See also aliases; Exposé; file 
permissions; Home folder; iDisk;
naming/renaming

arranging files, options for, 33
Bluetooth, moving with, 414
colors, organization by, 40
Column view, working in, 37
compressing, 33
copying, 44-45
Cover Flow, viewing with, 36
deleting, 48
documents, adding to, 189
e-mail as file, saving, 282
Icon view, viewing in, 32-33
Info window, information in, 50-51
instant messages, sending with, 303
kind

arrangement of files by, 33
Find window search for files by, 67

List view, working in, 34-35
moving, 44-45
Network Sharing Services, 404, 406-407
Quick Look, viewing in, 38
recently used files, opening, 133
restoring deleted files, 48-49
sorting by column, 35
Stationery Pad, 50-51

File Transfers manager in iChat, 303
filters. See also Quartz Filters

Spotlight results, filtering, 60
viewing information on, 459

Final Cut Pro, 334-335
Finder, 1. See also CDs; DVDs; Finder

Preferences; indexing
Application Services with, 436
Automator workflow from, 506
Help menu, 74
icon views, customizing, 82
introduction to, 4-5
mouse pointer in, 6
networks, browsing, 416-417
Simple Finder, 94
Spotlight results in, 63
toolbar, customizing, 84-85
undoing actions in, 43
window opening, customizing, 80

Finder Preferences, 26, 77
Advanced preferences pane, 78

description of, 78
file extensions, showing/hiding, 81
General preferences pane, 78
icons on desktop, specifying, 79
Label preferences pane, 78
Sidebar preferences pane, 78
spring-loaded folders, turning on/off, 46

finding/replacing
documents, text in, 176-177
Wrap Around option, 176-177

Find window
files, searching for, 66-67
hard to find information, searching 

for, 68
naming/renaming

files, 69
searches by name, 67

results, working with, 69
Finger service, 430
FireVault

Home folder, protecting, 397, 401
passwords with, 401
turning on/off, 397

firewalls, 221
configuring, 409
printers, sharing, 202-203

FireWire, 54
flash drives, 27
Flight tracker, Dashboard display, 158-159
folders, 25. See also aliases; Exposé; iDisk;

naming/renaming; Smart folders;
spring-loaded folders

arranging folders, options for, 33
Automator workflow from, 506
bookmarks folder, creating, 238
colors, organization by, 40

folders
Column view, working in, 37
compressing, 33
copying, 44-45
creating, 42
deleting, 48
icons, 10
Icon view, viewing in, 32-33
Info window, information in, 50-51
kind

arrangement of files by, 33
Find window search for files by, 67
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folders (continued)
List view, working in, 34-35
moving, 44-45
Quick Look, viewing in, 38
Recent Folders list, 39
restoring deleted folders, 48-49
Safari bookmarks, creating folder, 238
sorting by column, 35
Spotlight searches, keywords for, 57
types of, 26-27

Font Book, 129, 130
activating/deactivating fonts, 154
customizing fonts, 154-155
managing fonts with, 153

fonts
defined, 178
for document text, 178
for e-mail message text, 269
for iChat chats, 310
for instant message text, 300-301
locating, 155
on-screen smoothing, 455
Safari font preferences, setting, 253
size, 178
smoothing styles, changing, 100-101
Spotlight searches, keywords for, 57
TextEdit preferences, setting, 194

forcing a restart, 448
foreign languages. See languages
formatting. See also documents

copying/pasting, 187
disks, 438
e-mail message text, 269
instant message text, 300-301
international options, changing, 106-107
TextEdit preferences, setting, 194

forms, filling out, 242-243
Forward button on toolbar, 17
forwarding e-mail, 274-275
frames, 227

printing Web page frame, 246
Front Row, 130, 313

changing settings in, 341
media, viewing, 340
navigating and starting, 339
playing, 114

full-screen interface with DVD Player, 333

G
gestures

Ink Pad recognizing, 169
turning on/off, 128

Get Info button, 69
Get Info dialog box, 63
G5 architecture, 462
Gmail calendar account, 366
Go menu, 39
Google

Address Book from, 141
Application Services with, 436
clearing search settings, 256
Dashboard displaying, 158-159
iCal calendar account, 366
iChat, Google Talk with, 289, 290
Search box, 244-245

Grab, 436
screen shots, capturing, 149

Gracenote music title repository, 327
grammar checking. See spell and grammar

checking
Grapher, creating graphs with, 145
graphics. See also images

Quartz Extreme enhanced graphics, 102
RTFD files for, 164

grid settings, overriding, 33
grouping/ungrouping

iCal, creating calendar groups, 368-369
iChat buddy groups, managing, 298-299
Spotlight results, 62

GUI (graphic user interface), 1, 452
.gzip files, 251
opening, 434

H
hackers, firewalls and, 409
handwriting

documents, inserting handwritten text
in, 168-169

Chinese, in, 169
ink preferences, setting, 128

hard drive, 27. See also disk file system
Find window searching, 66
Info window, information in, 50-51
optimizing, 441
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System Profiler, viewing information
with, 447

Web page, opening, 230-231
hard to find information, searching for, 68
hardware, 449

ColorSync, matching colors to device
with, 458-459

compatibility, checking for, 462
installing devices, 450
for Mac for Windows, 466
preferences, 96

viewing, 451
problems, preventing, 462-463
removing devices, 464
Safe boot, performing, 463
settings, viewing, 451

hearing impaired users, preferences, 120
help

Assist Me, help with, 407
browsing for, 74-75
for iChat, 74, 292
for Internet connection, 221
MobileMe services online support, 364
searching for, 74-75
with Spotlight, 76
VoiceOver help, 123

hexadecimal color values, 456
highlight colors, 100
History list. See Safari
Home folder, 28-29, 388

desktop, opening from, 29
Drop Box folder, 47, 402
Find window searching, 66
FireVault protecting, 397, 401
managing files with, 400
Public folder, 28-29, 47, 402
Shared folder, 47, 402
Sites folder, 402

Home page. See Safari
hot spots, VoiceOver, 123, 126
HotSync reminder, 377
HTML (Hypertext Markup Language)

Dashcode, 162
documents in, 164
links to HTML files, adding, 193
opening HTML documents, 192
plain HTML code files, creating, 192-193

TextEdit, creating HTML documents
with, 192-193

Web page code, viewing, 248
HTTP (Hyper-Text Transfer Protocol), 231
hubs for LANs, 410
hyperlinks. See links
hyphenation, setting, 181

I
iBook sleeping options, 110
iCal, 130. See also iSync

adding calendar accounts, 366
adding calendar events, 370
attachments for event, working with, 370
Automator workflow from, 506
backing up calendar, 371
creating calendars with, 368-369
Dashboard displaying, 158-159
deleting events, 370
details of event, editing, 371
To Do lists

creating, 367
printing, 374

editing calendar events, 370-371
groups in calendar, creating, 368-369
importing/exporting events, 370
preferences, changing, 369
printing calendar and To Do lists, 374
publishing calendar, 372
restoring calendar, 371
shared calendars, finding, 372
Spotlight searches, keywords for, 57
subscribing to calendar, 372-373
viewing window, 366

iChat, 129, 130, 289, 343. See also Bonjour
accounts, creating, 290-291
adding buddies, 296
with AirPort, 308
alerts, setting, 312
animated GIF, creating, 297
appearance of chat, changing, 310
Application Services with, 436
audio chats, 304

enhancing, 306
automatically reopening chats, 311
away messages, 294
backdrops, adding, 306
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iChat (continued)
background of window, changing, 311
bandwidth speed for video chats, 

changing, 304-305
blocking buddies, 302
collecting chats in single window, 301
custom status messages, creating, 294
deleting

buddies, 296
groups of buddies, 299

downloading versions of, 291
e-mail, responding to, 274
emoticons, inserting, 300-301
files with message, sending, 303
formatting message text, 300-301
groups of buddies, managing, 298-299
help in, 74, 292
links with messages, sending, 303
notification alerts, 312
parental controls for, 392-393
passwords for, 291
performance and quality specs, 305
Photo Booth

effects, adding, 306
video clips in, 330

pictures
of buddies, 297
theater presentations, 306-307
of video chats, 305

receiving instant messages, 300
recording video chats, 307
renaming buddy groups, 299
sending instant messages, 300
sharing screens, 309
signing in and out, starting, 292
status, changing, 294
Status menu, using, 294-295
text, viewing chat as, 311
theater presentations, hosting, 306-307
turning on/off

groups, use of, 298
Status menu, 295

video chats, 304
backdrops, adding, 306
bandwidth speed, changing, 304-305
enhancing, 306
installing hardware for, 291
monitoring, 305

Photo Book effects, adding, 306
pictures of, 305
recording, 307
theater presentations, 306-307

viewing window, 293
view of buddy list, changing, 299

icons. See alsoTrash
copying, 10-11
customizing views of, 82-83
deselecting, 10-11
on desktop, 4
disk icons, displaying, 27
Finder Preferences for displaying, 79
moving, 10-11
selecting, 10
Sidebar, removing icon from, 16
for Spotlight, 55

Icon view, 30
arranging items in, 32-33
customizing window views, 82-83
spring-loaded folders, opening, 46

iDisk, 16, 343-344
backing up files to, 479
displaying files from, 359
managing files with, 358
passwords, changing, 363
preferences, setting, 360-361
Public folder, 359, 362

permissions, changing, 363
sharing, 362-363

iDVD, 52
exploring, 342

iListen, 118
Image Bar with DVD Player, 333
Image Capture, 130

Automator workflow from, 506
working with, 148

images. See also attachments
Address Book, adding images to, 144
documents, adding to, 189
iChat buddy picture, changing, 297
previewing, 150-151
Safari, saving Web page images in, 249
Spotlight searches, keywords for, 57

IMAP (Internet Messages Access Protocol),
261

mailboxes for, 279
iMovie, 342
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Import Bookmarks command, 237
Import Image command, 436
importing/exporting. See also iTunes

Address Book contacts, importing, 139
animated GIF, exporting movie as, 331
Automator workflows, 503
iCal events, 370
iTunes, music from CDs to, 317
mailboxes to Mail, 259
MP3 players, exporting music to, 326
QuickTime, exporting movies, 336-337

Inbox. See Mail
indents

documents, 181
for e-mail message text, 269

indexing, 55
Info window options, 51
search, files for, 67

Info window
file information on, 50-51
options, setting, 51

infrared (IR) technology, 225, 313
ink-jet printers, 196
Ink Pad, 168
ink preferences, setting, 128
installing. See also uninstalling

Dashboard widgets, 160
hardware devices, 450
printers, 198
software, 432
third-party applications, 131
Windows on Mac, 468-469

instant messages, 289. See also Bonjour;
iChat

SMS (short message service) text, 308
Intel-based Mac computers. See Mac for

Windows
inter-line spacing, 183
international options, changing, 106-107
Internet, 219. See also AirPort; download-

ing; firewalls; wireless connections
Assist Me button, 221
connecting to, 220-221
hardware problems, checking on, 462
history of, 219
modems, setting up, 222
multiple connections, 221, 225

parental controls for, 392-393
searching, 244-245
security, 221
sharing connections, 221, 405, 408
songs, finding names of, 327
status menus for connecting to, 226

Internet Explorer, 219
Internet Radio, 313

iTunes window settings, 315
listening to, 323

iPhones with iTunes, 325
iPhoto, 52. See also Front Row

Automator example workflow for, 497
description of, 342
e-mail, adding photos to, 268

IP (Internet Protocol). See also printers
identifying address, 419
for ISPs (Internet service providers), 220
Sharing Service requiring, 404

iPod Hi-Fi, 313
iPods

Automator example workflow for, 497
disks, 27
with iTunes, 325
unmounting, 54

iSight, 129, 291. See also Photo Booth
with Mac for Windows, 465, 472

ISPs (Internet service providers), 220
attachments and, 276
Safari preferences, setting, 253

iSync, 130
adding devices to, 375
deleting devices from, 375
HotSync reminder with PDAs, 377
options for synchronization, setting, 376
preferences, setting, 377
Safari bookmarks, synching, 239

italicizing
document text, 178
e-mail message text, 269
fonts, 155

iTunes, 52, 130, 313. See also Front Row
aspects of iTunes, viewing, 319
automatically playing CDs with, 316
backing up library, 327
Boot Camp Assistant and, 465
copyright laws and, 321
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iTunes (continued)
Dashboard displaying, 158-159
downloading

from CDs, 317
from iTunes Music Store, 318-319

iMix, creating, 321
importing/exporting

CDs, music from, 317
MP3 players, exporting music to, 326
playlists, 320, 322

iPhones with, 325
iPods with, 325
with Mac for Windows, 472
minimizing window, 319
multiple libraries, creating, 317
playing music from CDs, 317
playlists

burning music CDs from, 326
creating, importing/exporting, 320-322
media, adding, 322
Smart Playlists, building, 320-321

podcasts, listening to, 324
preferences, setting, 328
radio list, adding stations to, 323
setting up, 314
Smart Playlists, building, 320-321
starting, 314
viewing window, 315
volume control for, 114

iTunes Mini Store, 314
iTunes Music Store, 315

iMix, creating, 321
using, 318-319

J
Jabber and iChat, 289, 290
Java, Safari enabling, 254
JavaScript

Dashcode, 162
Safari, enabling in, 254

joining MobileMe community, 344
Junior voice, 118
junk e-mail, 284-285
justification

of document text, 178
of tables, 185

K
kerning, changing, 182
keyboards

Calculator, using with, 146
changing settings, 453
international options, changing, 106-107
with Mac for Windows, 465, 472-473
Universal Access options, 120-121
VoiceOver help, 126

keyboard shortcuts, 7
applications, switching between, 135
customizing, 453
with DVD Player, 333
for Exposé, 92
Spotlight, setting for, 64-65
turning on, 9
with VoiceOver, 126

Keyboard Viewer, 106-107
Keychain

access controls, setting, 383
adding keychains, 384
description of, 380
modifying, saving keychains, 382-383
working with, 381

keywords
for Find window searches, 67
for Internet searches, 244
for Spotlight searches, 57

kilometer to miles conversions, 146-147

L
labels. See also color labels

Address Book labels, 138, 141
files and folders arranged by, 33

landscape orientation printing, 205, 206
languages

dictionary sources, 174
in documents, 165
Info window options, 51
international options, changing, 106-107

LANs (local area networks). See also AirPort
Ethernet connection for, 223
iChat with, 308
setting up, 410
with Sharing Service, 404
Windows Vista computers, connecting

from, 425
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Windows XP computers, connecting
from, 426-427

laser printers, 196
layout

for fax documents, 215
for printing, 207

left-alignment
of document text, 178
of tables, 184

left indent marker, 181
libraries. See iTunes
Library folder, 26-29
Library pane on Automator window, 492
Light Tunnel effect, 331
line height/spacing, changing, 183
links

e-mail message, sending links in, 276
to HTML code files, 193
instant messages, sending with, 303

lists. See bulleted lists; numbered lists
List view, 30

color labels, sorting files and folders, 40
customizing window views, 82-83
rearranging, widening columns in, 35
showing/hiding folders in, 34
sorting files and folders in, 35-36
spring-loaded folders, opening, 46

local disk, 27
locking/unlocking preferences, 99
logging in, 1

items, specifying, 394
with Network Sharing Services, 405

logging out, 23
Login window, 2

actions from, 3
activating, 387
bypassing, 3

lowering characters, 182
LTP Over IPsec protocol, 428

M
MacBinary format, 251
MacBook OS X DVD, keeping, 399
Mac Finder. See Finder
Mac for Windows, 465. See also Boot Camp

Assistant
installing Windows on Mac, 468-469

multiple internal disks, removing
Windows from computer with, 474

preparing, 466-467
removing Windows, 474-475
starting after installation of, 470-471
using Windows on Mac, 472-473

Mac OS X, 478
applications, list of, 130
CD, restoring passwords with, 399
MacBook OS X DVD, keeping, 399
restarting with, 112
Time Machine for reverting to previous

version, 484-485
Windows files, copying, 472-473

Mail, 130, 257. See also Address Book;
attachments

accounts
adding, 261
advanced options, setting, 263
managing, 262-263
setting up, 258, 260

addressing e-mail, 266-267
advanced account options, setting, 263
Application Services with, 436
archiving e-mail, 281
authentication of, 263
backing up e-mail, 281
BCc address field, 265
blocking e-mail, 284-285
bouncing e-mail, 284-285
Cc field, 266
composing e-mail, 265
data detectors, managing information

with, 268
dates and times, setting, 104
deleting, 280-281

options, changing, 281
diverting incoming e-mail to mailboxes,

285
To Do items, tracking, 271
draft e-mail, saving, 282
file, saving e-mail as, 282
formatting message text, 269
forwarding e-mail, 274-275
grammar-checking e-mail, 265
importing mailboxes and e-mail, 258-259
incoming e-mail, setting rules for, 286
instant message, replying to e-mail with,

274
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Mail (continued)
junk e-mail options, 284-285
links in e-mail message, sending, 276
mailboxes

for backing up e-mail, 281
diverting incoming e-mail to, 285
new mailbox, creating, 278
organizing e-mail in, 279
Smart Mailbox, creating, 287
standard mailboxes, 278

Message List view, changing, 273
new e-mail, checking for, 272
new mailbox, creating, 278
notes

creating, 271
searching for, 283

offline viewing, keeping copies for, 263
opening e-mail, 272-273
Out of Office message, creating, 286
parental controls for, 392-393
passwords for, 258, 263
photographs, adding, 268
preferences for addressing, 266-267
previous recipients list, sending e-mail

with, 266-267
printing e-mail, 281
priority to mail, adding, 265
quoted text in, 274
reading and receiving e-mail, 272-273
recovering deleted e-mail, 280
redirecting e-mail, 274-275
replying to, 274
resending messages, 285
RSS feeds, subscribing to, 288
rules, creating, 286
saving e-mail, 282
searching e-mail for text, 283
sending e-mail, 265
servers, 260-261

removing mail from, 263
signatures, creating, 270
Smart Addresses, using, 266
Smart Mailbox, creating, 287
sorting messages, 279
speaking voice, adding, 268
spell-checking e-mail, 265
Spotlight searches, keywords for, 57
starting, 258

stationery, adding, 268
threads, sorting e-mail by, 279
to-do tasks

searching for, 283
tracking, 271

Trash mailbox, 278
window, viewing, 264

maintaining computer, 431
master password, restoring, 398-399
maximizing/minimizing

changing options, 100
Dock, 88
iTunes window, minimizing, 319
slowing minimization, 89

media
Front Row, viewing in, 340
iTunes playlists, adding to, 320, 322

Media browser for Automator workflows,
503

memory
calculation results, saving, 147
Info window options, 51
system memory, viewing, 445

menu bar, 5
Bluetooth placed on, 413
clock, using, 105
Displays icon on, 454
rearranging status icons on, 8
status of fax, showing, 217

menus
contextual menus, 8
language options, setting, 106-107
pull-down menus, 8
working with, 7

metadata, 55
specific metadata, searching for, 68
Spotlight, finding information with, 56

microphones with iChat, 304
Microsoft. See also Mac for Windows;

Microsoft Word; Windows Vista;
Windows XP

Excel, Address Book for faxes with, 218
Exchange 2007 

calendar, 366
Mail server, 260

Internet Explorer, 219, 227
Outlook/Outlook Express, importing e-

mail to, 259
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Microsoft Word
Address Book for faxes with, 218
documents as files, 164, 190
formatting text in documents, 178
opening documents in, 29
Page Setup options, 204-205

MIDI
devices, configuring, 460-461

Mighty Mouse. See Apple Mighty Mouse
MiniDV camcorders with iMovie, 342
Minimize button for windows, 12, 15
mini restarts, 448
MobileMe, 343. See also iDisk; iSync

accessing account, 345
Address Book, 350-351
backing up files with, 358-359
calendar, adding, 352

events, 353
preferences, 353

connecting to computer with, 420-421
e-mail, managing, 348-349
gallery, 354-357

creating and modifying, 354-355
viewing and sharing, 356-357

iDisk, sharing, 362-363
joining MobileMe community, 344
Mail services, 348-349
online support, obtaining, 364
preferences for account, changing, 

346-347
signing on to, 345

MobileMe synchronization
resetting, 379
setting up, 378

modems, 220. See also cable modems
configuring connection, 220
setting up connection, 222

monitors. See also colors
display settings, changing, 454-455
fonts on screen, smoothing, 455

mounting disks, 54
mouse. See also Apple Mighty Mouse

changing settings, 452
pointer, 6
Universal Access options, 120-121
windows, resizing, 15
working with, 6

Mouse Keys, 120-121

movies. See videos
Movies folder, 28-29
moving. See also drag-and-drop; navigating

Address Book contacts, 140
Bluetooth, items with, 414
Dock items, 89
documents, text in, 167
with Exposé, 45
files and folders, 44-45
icons, 10-11
Mailboxes on screen, 279
Safari, bookmarks in, 237
Sidebar, moving folders with, 16
spaces, window between, 21
windows, 14

MP3 players, exporting music to, 326-327
MR (Memory Recall) button, 147
multi-function devices, 196
music, 313. See also CDs; Front Row;

iTunes; MIDI
finding names of songs, 327
Spotlight searches, keywords for, 57

Music folder, 28-29
muting sounds, 114

N
naming/renaming. See also Find window;

Keychain
color label names, changing, 41
files and folders, 42-43

arranging by names, 33
iChat buddy groups, 299
Info window options, 51
Mailboxes, 279
Safari Bookmarks Library collection, 239
user accounts, short name for, 388

Nature Background, 102
navigating

in dialogs, 9
Front Row, 339
with VoiceOver, 123, 124
Web pages, 230-231

nesting tables, 185
Netscape Navigator, 219, 227

Mail, importing e-mail to, 259
NetStat, 430
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network disks, 27
Info window, information in, 50-51

Network Preferences pane, connecting to
Internet with, 226

network printers, 202-203
accessing shared printers, 202-203
installing, 198

networks, 403. See also AirPort; Bluetooth;
LANs (local area networks); network
printers; Network Sharing Service

activity, viewing, 445
Bonjour messaging on, 289
Finder, browsing with, 416-417
other computers, connecting to, 418-419
port configuration, 225
privileges for users and groups, creat-

ing, 406
searching for files on, 417
several computers, connecting to, 418
Sidebar, accessing from, 417
System Profiler, viewing system infor-

mation with, 447
utilities, 430
VPN (Virtual Private Network), VLAN

(Virtual Local Network), connecting
with, 428-429

Windows, sharing Mac files with, 424
Network Sharing Service, 404-405

file sharing, setting up, 406-407
Internet Sharing, 408

Network Utility, 430
New dialog box, 496
no access for network users, 406
nonresponding applications, quitting, 136
notes. See also Mail; Sticky Notes

Keychain, adding secure notes with, 381
NOT operator, searching with, 57
NPR, listening to, 323
NSFNET, 219
NTFS, reformatting with, 468
NTSC format with iMovie, 342
numbered lists, 184

in e-mail message text, 269
numbering

international options, changing, 106-107
recent items, changing numbering of,

100-101
NumPad Commander, 123, 125

O
online support from MobileMe, 364
Open dialog box in Automator, 496
opening

applications, 133
Dashboard, 156
disks, 26-27
documents, 28-29
Info window options, 51
recent applications and documents, 39
recently used applications, 133
Scripts menu, scripts from, 511
windows, 12-13

operating system, 1
optimizing hard drive, 441
Option buttons in dialogs, 9
orientation for printing, 205, 206
OR operator, searching with, 57
outlining

document text, 178
fonts, 155

Out of Office message, creating, 286

P
page breaks, inserting and deleting, 183
Page Setup

individual defaults, setting up, 205
for printers, 200
printing and range options, 204-206
for text wrap, 181

pages per minute (ppm), 196
PAL format with iMovie, 342
Palm OS devices. See PDAs (personal data

assistants)
panes. See also specific panes

working with, 7
paper feed for printing, 207
paper handling for fax documents, 215
paper size for printing, 200, 204, 206
paragraphs

indent markers, 181
spacing, 183

parental controls
for Dictionary, 175
logging activity with, 392
time limits, setting, 393
for user accounts, 391, 392-393
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partitioning disks, 467
passwords. See also Keychain

with FireVault, 397, 401
hints, adding, 388
for iChat, 291
iDisk passwords, changing, 363
for Internet connections, 220
for logging out, 23
from login window, 387
for MobileMe account, 346-347
for Mail, 258, 263
master password, restoring, 398-399
on shared computers, 3
in Simple Finder, 94
tips on creating, 398

Paste command, 44
pasting

Automator workflows, 503
formatting, 187
ruler, 179

PDAs. See also iSync
Bluetooth with, 412
networks with, 403

PDF files
documents as PDF files, saving, 209
downloading Acrobat Reader, 209
previewing, 150-151
Safari, viewing in, 247
Saving in, TextEdit, 190
Spotlight searches, keywords for, 57
working with, 151

pen cursors, 128
People, Dashboard displaying, 158-159
permissions. See also file permissions

for screen sharing, 422
phones. See cell phones
Photo Album, Automator example for, 497
Photo Booth, 130, 313. See also iChat

animated GIF, creating, 297
capturing photos in, 329
effects, adding, 331
proof sheets, 329
videos

effects, 306
recording, 330

Photo Browser, 268
photographs. See also Front Row

e-mail, inserting in, 268
iChat buddy picture, changing, 297

Photoshop Preview, opening files in, 150
pictures. See images
Pictures folder, 28-29
Ping service, 430
Pipe Organ voice, 118
Places section, Sidebar, 16
Plain Text Encoding pop-up, 165
Plain Text files

documents as Plain Text files, saving, 191
TextEdit preferences, setting, 194

playlists. See iTunes
plug-and-play devices, 450
plug-ins

Automator with, 499, 506
compatible plug-ins, checking, 255
Safari, enabling in, 254

podcasts. See also Front Row
listening to, 324

pointing with mouse, 6
POP (Post Office Protocol), 261
pop-up menus, 8

in dialogs, 9
on toolbar, 17

pop-up windows, blocking, 255
portrait orientation printing, 205, 206
PostScript files, 201

PDF file, converting to, 150
PowerBook/MacBook

sleeping options, 110
wireless connections, 224

power failure restart options, 110-111
power strips, 450
ppm (pages per minute), 196
PPoE (Point to Point Protocol over

Ethernet), 223
making connection with, 226

PPTP protocol, 428
preferences. See also Finder Preferences;

hardware; iChat; Safari; System
Preferences

Bluetooth preferences, setting, 415
Dictionary preferences, setting, 174-175
Dock preferences, setting, 88-89
iCal preferences, changing, 369
iDisk preferences, setting, 360-361
iSync preferences, setting, 377
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preferences (continued)
iTunes preferences, setting, 328
Language & Text, 106-109
MobileMe account preferences, chang-

ing, 346-347
Mail, addressing, 266-267
Sidebar preferences, changing, 86-87
Spotlight preferences, customizing, 64
TextEdit preferences, setting, 194
for Time Machine, 478
VoiceOver preferences, setting, 124-125

presentation keyword for Spotlight, 57
Preview, 130, 150-151
Preview column, Column view, 37
Preview File Open command, 150
previewing

dialogs, area in, 9
Info window options, 51
printed documents, 208
print image, 206

Print command, 206-207
printer drivers, 197
printers. See also Bonjour; network printers

adding or removing, 198-199
default settings, setting, 200
description of, 196
desktop printers, using, 210
IP (Internet Protocol)

for installing printers, 199
for sharing printers, 202-203

manually adding, 198-199
Network Sharing Services, 404
PostScript Printer Desc. (PPD) files, 201
sharing, 202-203, 404
Sharing Service, 404
specific settings, setting, 201

Printer Setup Utility, printer drivers in, 197
Printers folder, displaying printers in, 210
Print & Fax pane, 200-201
printing, 195

from Address Book, 141
Automator workflow, 505
basic print options, setting, 206-207
cover pages, creating, 207, 213
e-mail messages, 281
help topics, 75

iCal calendar and To Do lists, 374
Page Setup options, 204-205
previewing printed documents, 208
queues, managing, 210, 211
reverse order printing, 207
running print jobs, 212
saving print options, 215
scheduling jobs, 212
to shared printers, 203
two print jobs with two printers, 205
Web pages, 246

Print Queue utility, 210
privacy preference in Spotlight, 64-65
Private Browsing, 230
privileges for users and groups, 406
proof sheets in Photo Booth, 329
protocols, 261
proxies, 220
Public folder. See also iDisk

in Home folder, 28-29, 47, 402
publishing iCal calendar, 372
pull-down menus, 8
Push button in dialogs, 9

Q
Quartz Extreme enhanced graphics, 102
Quartz Filters

Automator example workflow for, 497
for fax documents, 216
for printed documents, 207

Quick Erase setting, 338
Quick Look

attachments, viewing, 276-277
toolbar button, 17
viewing files with, 38

QuickTime movies, 330
iMovie and, 342
streaming options, 334-335
in theater presentations, 307

QuickTime Player, 130, 313
creating and editing movies, 336-337
playing movies, 334-335
sharing movies, 336-337

quitting applications, 136
quoting text in e-mail, 274
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R
radio. See also Internet Radio

podcasts, listening to, 324
raising characters, 182
read and write permissions

for moving/copying files, 45
for network users, 406
in Shared folder, 47

read-only permissions
documents as read-only files, 190
for moving/copying files, 45
for network users, 406
in Public folder, 47

Recent Folders list, 39
recently used items

applications, opening, 133
documents, opening, 165
numbering, changing, 100-101

recording
AppleScripts, 510
Automator actions, 502
video chats, 307

recovering. See restoring
Redo command, 43
redoing. See undoing/redoing
refresh rate, setting, 454
registration symbol, inserting, 188
reloading Web pages, 230-231
removable disks, 27

Info window, information in, 50-51
Rendezvous Web sites, adding, 238
replacing. See finding/replacing
resizing. See size/resizing
resolution

monitor resolution, setting, 454
of printers, 196

restarting, 24
forcing a restart, 448
from Login window, 3
with Mac OS X, 112, 442
power failure restart options, 110-111
in Target Disk Mode, 112
Time Machine backup for, 481

restoring
calendar with iCal, 371
compressed files and folders, 436
deleted files and folders, 48-49

disk image, 489
e-mail, 280
master password, restoring, 398-399

Return key, 9
reverse order

fax documents, sending, 215
printing pages in, 207

RGB (Red, Green, Blue) colors, 456
right-alignment

of document text, 178
of tables, 184

right indent marker, 181
routers, 220, 408
RSS feeds. See also Safari

customizing, 240
Mail, subscribing in, 288
widgets and, 156

RTFD files, documents as, 164
RTF files

documents as, 164, 190
formatting text in, 178

rulers, showing/hiding, 179

S
Safari, 130

Address Book to Bookmarks bar, adding,
238-239

advanced preferences, setting, 253
alerts for nonsecure forms, 243
appearance preferences, setting, 253
AutoFill preferences, setting, 242
bookmarks, 228

creating and deleting pages, 237-239
folder, creating, 238
organizing, 239
for RSS feeds, 240-241
Spotlight searches, keywords for, 57
synching on multiple computers, 239
tabs, opening with, 232-233

Bookmarks Library, 237
deleting bookmarks in, 238-239
organizing bookmarks in, 239
renaming collection, 239

cache, emptying, 236
compressing/uncompressing disk

images, 251
cookies, preferences regarding, 254
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Safari (continued)
copying text from Web page, 249
customizing window, 228
default browser, selecting, 256
deleting

bookmarks, 238-239
History list entries, 236

different window, opening page in, 233
disk images, downloading, 251
downloading

files, downloading, 250-251
Home page, 252

Downloads window, working with files
in, 250-251

encoding preferences, setting, 253
font preference, setting, 253
forms, filling out, 242-243
general preferences, setting, 252
grammar-checking in, 243
help information in, 74
History list

clearing settings, 256
preferences, setting, 252
viewing, 236

Home page
changing, 235
going to, 230-231
preferences, setting, 252

HTML code, viewing, 248
navigating in, 230-231
nonworking Web pages, 255
opening Web pages in, 230
PDF files, viewing, 247
pictures from Web page, saving, 249
pop-up windows, blocking, 255
preferences

advanced preferences, 253
appearance preferences, 253
general preferences, 252
security preferences, setting, 254

printing Web pages, 246
reloading pages, 230-231
resetting settings for, 256
RSS feeds

bookmarking, 240-241
customizing, 240

saving
information in Web page, 248-249

text of Web page, 248
security

pop-up windows, blocking, 255
preferences, setting, 254

security preferences, setting, 254
size of text, changing, 233
SnapBack page, 245
spell-checking in, 243
starting application, 228
style sheet preferences, 253
synching bookmarks on computers, 239
tabs

opening Web page with, 232-233
setting browsing options for, 232

Top Sites, 234
viewing window, 229
Web Clip widgets, creating, 162

Safe boot, performing, 463
Samba server software, 424
Save As dialog box, 190
saving. See also Safari

attachments, files in, 277
Automator workflow, 505
Bonjour chats, 309
e-mail, 282
Keychain, changes in, 383
print options, 215
Smart folders, copy of, 71
Web page information, 248-249

scanner information, viewing, 447
scheduling. See also iCal

fax documents, 215
faxes, 217
print jobs, 207, 212

screen savers, setting up, 103
screen sharing

permissions, setting, 422
using, 423

screen shots, capturing, 149, 336-337
Script Editor, 510

Application Services with, 436
Script menus. See also AppleScripts

adding scripts to, 509
Automator workflow from, 506
displaying, 508
opening scripts from, 511

scroll bars
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changing action of, 100
options, changing, 100

search boxes
in Automator, 493, 494
on toolbar, 17
for windows, 12

search engines, 244-245
Search For section, 16

Smart folders, using, 72-73
searching. See also Dictionary;

finding/replacing; Find window;
Spotlight

Automator workflows, 503
e-mail for text, 283
for hard to find information, 68
for help, 74-75
Internet, 244-245
metadata searches, 68
network, files on, 417
with VoiceOver, 123

secret folder hierarchy menu, 39
security. See also Keychain; passwords;

Safari
Internet security, 221
for logging out, 23
for switching between users, 22-23
system security preferences, setting, 397

selecting
documents, text in, 166
icons, 10

Sepia effect, 331
servers. See also Mail

Find window searching, 66
Web Sharing service, 404

Shared folder in Home folder, 47, 402
Shared section, Sidebar, 16
sharing. See also network printers; Network

Sharing Service; screen sharing
Address Book, 138, 142-143
buddies, screens with, 309
Home folder, sharing files in, 402
iCal calendars, 372
iChat screens, 309
Internet connections, 221
Network Sharing Services, 404-405
printers, 202-203, 404
starting on shared computer, 2-3
widgets, 156

Windows, Mac files with, 424
Windows Vista computers, connecting

from, 425
Sharing Preferences, 404
shortcuts. See aliases; keyboard shortcuts
Show All command on Spotlight menu, 58
showing/hiding. See also Dock

applications, 134
Dashboard, widgets on, 158
with Exposé, 20
file extensions, 81
List view, folders in, 34
Mailbox list, 279
rulers, 179
Sidebar and toolbars, 16-17, 86

Show Inspector, 50
Show Modem Status menu, 222
Show View Options command, 32
shutting down, 24

from Login window, 3
options, setting, 110-111

Sidebar
customizing, 86-87
networks, accessing, 417
preferences, changing, 86-87
shared devices, displaying, 420
showing/hiding, 16, 17, 86
Smart folders, using, 72-73
using, 16
for windows, 12

sight impaired users, preferences, 120-121
signatures to e-mail, 270
Simple Finder, 94
Sites folder, 28-29

in Home folder, 402
size/resizing. See also compressing/uncom-

pressing
files and folders arranged by size, 33
Find window searches by size, 67
font size, 178
help text, 75
Web page text, 233
windows, 12, 14-15

Ski Report, Dashboard displaying, 158-159
sleep mode, 24

faxes, turning off to receive, 216-217
from Login window, 3
setting sleep options, 110-111
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slider in dialogs, 9
slideshows for Spotlight results, 63
Slow Keys, 120-121
Smart folders

changing search criteria for, 73
creating and editing, 70-71
saving copy of, 71
Sidebar, using in, 72-73

Smart Mailbox, creating, 287
Smart Playlists, building, 320-321
smart searches with VoiceOver, 123
SMB/CIFS

file services, 424
sharing printers with, 202-203

smileys in instant messages, 300-301
smoothing fonts on screen, 455
SMS (short message service) text, sending,

308
SMTP (Simple Mail Transfer Protocol), 261
SnapBack page, 245
Snap to Grid setting, 33
software. See also hardware

automating updates, 433
compatibility, checking for, 462
downloading, 432
installing, 432
removing hardware device software, 463
uninstalling, 48, 432

Solid Colors Background, 102
sorting

by color labels, 40-41
e-mail messages, 279
Find window file results, 69
List view, files and folders in, 34-35
Spotlight results, 62
widgets, 161
sounds. See also alerts; VoiceOver
changing sound effects, 114
dates and times, announcing, 105
in Front Row, 341
input options, setting, 115
MIDI devices, configuring, 460-461
output options, setting, 115
Spotlight searches, keywords for, 57

Spacebar with spring-loaded folders, 46
Spaces, 130

customizing, 93
Dashboard preferences, changing, 157

grouping windows into, 21
spacing

character spacing, changing, 182
line spacing, changing, 183

Speakable Commands window, 116
speaking voice. See also Alex; VoiceOver

document text, speaking, 175
for e-mail, 268
interface options, setting, 119

speech recognition, 116-117. See also Alex
with Address Book, 138, 141
Application Services with, 436
enabling, 117
for Sticky Notes, 152
using, 117

speed of printers, 196
spell and grammar checking, 163

adding words to dictionary, 172
for documents, 172-173
e-mail, 265
in Safari, 243
in Spotlight, 59

Spotlight, 55
backed-up items, recovering, 482-483
canceling search, 57
desktop icon, 5
e-mail, searching for, 283
filtering results, 60
finding information with, 56-57
grouping results, 62
help with, 76
keyboard shortcuts, setting, 64-65
keywords for searches, 57
metadata, finding information with, 57
preferences, setting, 64-65
privacy preferences, setting, 64-65
sorting results, 62
viewing results in window, 58-59
windows, working with, 58-59
working with results, 63

Spotlight Search box, 76
spring-loaded folders

customizing, 80
using, 46

stacks on Dock, 19
starting. See also restarting

Automator, 495
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Bonjour messaging, 309
CDs, changing start settings for, 113
DVDs, changing start settings for, 113
with Fast Startup Switch, 442
Front Row, 339
iChat, 292
iTunes, 314
Mac for Windows, 470-471
Mac OS 9 disk, starting from, 442
power failure restart options, 110-111
Safe boot, performing, 463
specifying startup items, 394-395
stand-alone computer, 2

Startup commands, 395, 399
startup disk, 26-27

selecting, 112
Startup Disk Control Panel, 112
stationery for e-mail, 268
Stationery Pad in Info window, 50-51
status bar

in Safari, 228
for windows, 12

status menus
in iChat, 294-295
Internet, connecting to, 226

Sticky Keys, 120-121
Sticky Notes, 130

Application Services with, 436
creating, 152
Dashboard displaying, 158-159

Stocks, Dashboard displaying, 158-159
Stuffit Expander, 33, 131, 434
styles

deleting style favorites, 186-187
documents, applying to, 186-187
favorite styles, applying, 186-187
for fonts, 155
Safari style sheets, 253
toolbar styles, changing, 85

submenus, 8
subnet masks, 220
subscribing

to Address Book, 143
to iCal calendar, 372-373
to podcasts, 324
to RSS feeds, 288

subscript characters, 182

summary
of Application Services, 436
of printer options, 207

superscript characters, 182
surge protectors, 450
switching

between applications, 134-135
between Dock applications, 18
Fast User Switching, enabling, 396
between help libraries, 74
between users, 22-23
between windows, 14

symbols. See also copyrights; trademarks 
registration symbol, inserting, 188

synchronization. See also iSync; MobileMe
synchronization

of Address Book, 138
Safari bookmarks on multiple 

computers, 239
System Administrator. See Administrator
System folder, 26-27
System Preferences, 95. See also hardware;

monitors; QuickTime movies;
VoiceOver

appearance options, changing, 100-101
Bluetooth preferences, setting, 415
dates and times, setting, 104-105
description of, 96-97
desktop backgrounds, changing, 102
ink preferences, setting, 128
international options, changing, 106-107
Internet preferences, list of, 96-97
keyboard settings, changing, 453
language & text options, 171, 172
locking/unlocking, 99
mouse settings, changing, 452
network preferences, list of, 96-97
overall preferences, list of, 97
personal preferences, list of, 96
Print & Fax pane, 200-201, 202-203
screen savers, setting up, 103
Security pane, 397
sleeping options, setting, 110-111
sounds, controlling, 114-115
speaking voice, setting, 118-119
speech recognition options, 116-117
Spotlight searches, keywords for, 57
Startup disk, selecting, 112
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System Preferences (continued)
Universal Access preferences, 120-121
viewing, 98

System Profiler, viewing system informa-
tion with, 447

system recovery with Time Machine, 484

T
tab bars in Safari, 228
tables

cells, 184-185
documents, adding to, 184-185
merging cells in, 185
nesting tables, 185

tabs. See also Safari
in dialogs, 9
paragraph tabs, setting, 180

tab stops, setting, 180
tactile feel of keyboard, 453
Take Video Snapshot button, 144
.tar files, opening, 434
Target Disk Mode, restarting computer, 112
TCP/IP, 422

for modems, 222
telephones. See cell phones
television podcasts, listening to, 324
text. See also documents; Mail

encoding, selecting, 228
iChat chat as text, viewing, 311
in Safari, 228
substitution, preferences, 108-109

TextEdit, 29, 130, 163. See also documents
Application Services with, 436
automatic opening documents in, 81
Page Setup options, 204-205
preferences, setting, 194
speaking text in, 175
for Web design, 192-193

text substitution, 108-109, 171
text wrap

changing, 181
TextEdit preferences, setting, 194

theater presentations, hosting, 306-307
thesaurus, 174
third-party applications. See also software

installing, 131
System Preferences, 97

threads, sorting e-mail by, 279
Time Capsule, 478, 481
Time Machine, 130, 477

entire computer system, recovering, 484
excluding items from backup, 480
preferences, setting up, 478
previous version of Mac OS X, reverting

to, 484-485
recovering backed-up items, 482-483
restarting backup, 481
setting up, 478
starting manual back up, 479
system, recovering, 484-485
working with backup, 481

time management. See iCal
times. See dates and times
time zones, setting, 104
title bars

aliases, creating, 91
for windows, 12

To Do lists. See also Mail
iCal, creating with, 367

Toolbar Control button, 12
toolbars. See also Automator

adding icons to, 85
customizing, 84-85
deleting icons from, 85
Finder toolbar, customizing, 84-85
parts of, 17
rearranging icons on, 85
in Safari, 228
showing/hiding, 16, 17
styles for, 85
for windows, 12
working with, 7

trademark symbols
documents, inserting in, 188

Translation, Dashboard displaying, 158-159
Trash, 10

empty Trash warning, turning on/off, 49,
81

files and folders in, 48
securely deleting files and folders, 49
software, uninstalling, 48, 432
uninstalling software with, 48, 432

troubleshooting
Bonjour problems, 308
disk problems, 440
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hardware problems, 462-463
Safe boot, performing, 463

turning on/off. See also iChat
Bonjour, 308
Dock hiding, 18
empty Trash warning, 49, 81
FireVault, 397
Front Row settings, 341
gestures, 128
keyboard shortcuts, 9
spring-loaded folders, 46

U
underlining

document text, 178
e-mail message text, 269
fonts, 155

Undo command, 43
undoing/redoing

Address Book mistakes, 141
documents, actions in, 170
file deletions, 49
in Finder, 43
ink recognizing, 128

Unicode for languages, 165
uninstalling

hardware, 464
software, 48, 432

Unit Converter, Dashboard display, 158-159
Universal Access, 120-121. See also

VoiceOver
Automator actions and, 502

UNIX compressed files, opening, 434
unmounting networks, 54
updating

automating software updates, 433
from Boot Camp beta, 467
widgets, 157

up/down arrows in dialogs, 9
URLs (Uniform Resource Locators), 230

Application Services with, 436
home page, typing address for, 235

user accounts, 386
access privileges, setting, 391
adding, 388
deleting, 389
Fast User Switching, enabling, 396

file permissions, setting, 390
parental controls, setting, 391, 392-393
short name for, 388

user names for Internet connections, 220
Users folder, 28-29
Utilities folder, 489

V
Variable list on Automator window, 492-

493, 494
vCards, 139, 142-143

in attachments, 276
e-mail, including with, 270

verbosity preferences, setting, 124
video cameras, 291
videos. See also DVD Player; Front Row;

iChat; Photo Booth; QuickTime
movies; QuickTime Player

animated GIF, exporting movie as, 331
Dashboard displaying, 158-159
documents, adding to, 189
iMovie, 342
Spotlight searches, keywords for, 57

View buttons on toolbar, 17
views and viewing. See also specific views

changing window views, 30-31
customizing views, 30
disks, viewing, 26-27
documents, viewing, 28-29
hardware settings, 451
iCal window, 366
iTunes window, 315
System Preferences, 98

Virtual Network Computing (VNC), 422
visible files, searching for, 67
VoiceOver, 120

Braille, support for, 122, 125
commands, using, 126-127
description of, 122-123
hot spots, 123, 126
keys for, 123
preferences, setting, 124-125
searches and utility, 123

VO keys, 123
volume. See sounds
Volume desktop icon, 5
VPN (Virtual Private Network), 428
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VLAN (Virtual Local Area Network), 429

W
Wacom for handwriting recognition, 168
waking up options, setting, 110-111
Watch Me Do action, 502
Weather, Dashboard displaying, 158-159
Web addresses. See URLs (Uniform

Resource Locators)
Web browsers, 227. See also Safari

default browser, selecting, 256
history of, 219
Mail, starting, 259

Web Clips widget, creating, 162
Web pages. See also HomePage; RSS

feeds; Safari
copying text from, 249
different window, opening page in, 233
Image Capture, building with, 148
navigating, 230-231
nonworking Web pages, 255
printing, 246
reloading, 230-231
saving, 248
searching within, 244-245
size of text, changing, 233

Web sites, 227. See also HomePage; Web
pages

for printer driver downloads, 197
Whois service, 430
widgets, 156. See also Dashboard
Wikipedia, 174
windows, 1

activating, 12-13
Column view opening new windows, 37
Exposé, using, 20
Finder Preferences for customizing, 80
mouse, resizing with, 15
opening/closing, moving, 12-14
sizing/resizing, 12, 14-15
spaces, grouping windows into, 21
switching between, 14
TextEdit preferences, setting, 194
views, changing, 30-31

Windows Media
Boot Camp Assistant and, 465
with Mac for Windows, 472

Windows 7 or Vista. See also Mac for
Windows

LANs, connecting to, 425
upgrading Windows XP to, 468

Windows XP. See also Mac for Windows
LANs, connecting to, 426-427
outside network, connecting, 426-427
upgrading to Windows Vista, 468

WinZip, opening files compressed by, 434
wireless connections, 220. See also AirPort;

Bluetooth
infrared technology, 225

WordPerfect Page Setup options, 204-205
workflow. See Automator
World Clock, displaying, 158-159
write-only permissions for net users, 406
WYSIWYG, 208

X
X-Ray effect, 331

Y
Yahoo calendar account, 366

Z
Zoom button, 12, 15
zooming in/out

with DVD Player, 333
in Preview, 151
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